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Seller warrants the goods sold hereunder, under normal use and service as
described in the operator's manual, shall be free from defects in workmanship and
material for twelve (12) months, or the length of time specified in the operator's
manual, from the date of shipment to the customer. This warranty period is
inclusive of any statutory warranty. This limited warranty is subject to the following
exclusions:

a. Hot-wire or hot-film sensors used with research anemometers, and certain other
components when indicated in specifications, are warranted for 90 days from
the date of shipment.

b. Parts repaired or replaced as a result of repair services are warranted to be free
from defects in workmanship and material, under normal use, for 90 days from
the date of shipment.

c. Seller does not provide any warranty on finished goods manufactured by others
or on any fuses, batteries or other consumable materials. Only the original
manufacturer's warranty applies.

d. Unless specifically authorized in a separate writing by Seller, Seller makes no
warranty with respect to, and shall have no liability in connection with, goods
which are incorporated into other products or equipment, or which are modified
by any person other than Seller.

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS
stated herein. NO OTHER EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR
PARTICULAR PURPOSE OR MERCHANTABILITY IS MADE.

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER
OR BUYER, AND THE LIMIT OF SELLER'S LIABILITY FOR ANY AND ALL LOSSES,
INJURIES, OR DAMAGES CONCERNING THE GOODS (INCLUDING CLAIMS BASED
ON CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR OTHERWISE) SHALL
BE THE RETURN OF GOODS TO SELLER AND THE REFUND OF THE PURCHASE
PRICE, OR, AT THE OPTION OF SELLER, THE REPAIR OR REPLACEMENT OF THE
GOODS. IN NO EVENT SHALL SELLER BE LIABLE FOR ANY SPECIAL,
CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER SHALL NOT BE
RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS
OR CHARGES. No Action, regardless of form, may be brought against Seller more
than 12 months after a cause of action has accrued. The goods returned under
warranty to Seller's factory shall be at Buyer's risk of loss, and will be returned, if at
all, at Seller's risk of loss.

Buyer and all users are deemed to have accepted this LIMITATION OF WARRANTY
AND LIABILITY, which contains the complete and exclusive limited warranty of
Seller. This LIMITATION OF WARRANTY AND LIABILITY may not be amended,
modified or its terms waived, except by writing signed by an Officer of Seller.
Knowing that inoperative or defective instruments are as detrimental to TSI as they
are to our customers, our service policy is designed to give prompt attention to any
problems. If any malfunction is discovered, please contact your nearest sales office
or representative, or call TSI at 1-800-874-2811 (USA) or (651) 490-2811.
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Software License
(effective March 1999)

Trademarks

1. GRANT OF LICENSE. TSI grants to you the right to use one copy of the
enclosed TSI software program (the “SOFTWARE”), on a single computer. You may
not network the SOFTWARE or otherwise use it on more than one computer or
computer terminal at the same time.

2. COPYRIGHT. The SOFTWARE is owned by TSI and is protected by United
States copyright laws and international treaty provisions. Therefore, you must
treat the SOFTWARE like any other copyrighted material (e.g., a book or musical
recording) except that you may either (a) make one copy of the SOFTWARE solely
for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard
disk provided you keep the original solely for backup or archival purposes.

3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you
may transfer the SOFTWARE and accompanying written material on a permanent
basis, provided you retain no copies and the recipient agrees to the terms of this
Agreement. You may not reverse-engineer, decompile, or disassemble the
SOFTWARE.

4. DUAL MEDIA SOFTWARE. If the SOFTWARE package contains multiple types
of media, then you may use only the media appropriate for your single-user
computer. You may not use the other media on another computer or loan, rent,
lease, or transfer them to another user except as part of the permanent transfer
(as provided above) of all SOFTWARE and written material.

5. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and
documentation are provided with RESTRICTED RIGHTS. Use, duplication, or
disclosure by the Government is subject to the restrictions set forth in the “Rights
in Technical Data and Computer Software” Clause at 252.227-7013 and the
“Commercial Computer Software - Restricted Rights” clause at 52.227-19.

6. LIMITED WARRANTY. TSI warrants that the SOFTWARE will perform
substantially in accordance with the accompanying written materials for a period
of ninety (90) days from the date of receipt.

7. CUSTOMER REMEDIES. TSI's entire liability and your exclusive remedy shall
be, at TSI's option, either (a) return of the price paid or (b) repair or replacement of
the SOFTWARE that does not meet this Limited Warranty and which is returned
to TSI with proof of payment. This Limited Warranty is void if failure of the
SOFTWARE has resulted from accident, abuse, or misapplication. Any
replacement SOFTWARE will be warranted for the remainder of the original
warranty period or thirty (30) days, whichever is longer.

8. NO OTHER WARRANTIES. TSI disclaims all other warranties, either express or
implied, including, but not limited to implied warranties of merchantability and
fitness for a particular purpose, with regard to the SOFTWARE and the
accompanying written materials.

9. NO LIABILTY FOR CONSEQUENTIAL DAMAGES. In no event shall TSI be liable
for any damages whatsoever (including, without limitation, special, incidental,
consequential or indirect damages for personal injury, loss of business profits,
business interruption, loss of information or any other pecuniary loss) arising out
of the use of, or inability to use, this SOFTWARE.

Aerosol Instrument Manager is a registered trademark of TSI Incorporated.
Scanning Mobility Particle Sizer and SMPS are trademarks of TSI Incorporated.
Microsoft, Windows, Windows Vista, Access, and Excel are registered trademarks
of Microsoft Corporation.
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About This Manual

Purpose

This is an instruction manual for the Aerosol Instrument Manager®
Software as it applies to a TSI Scanning Mobility Particle Sizer™
(SMPS™) Spectrometer.

Related Produ

ct Literature

a

a

Model 3934 Scanning Mobility Particle Sizer™ (SMPS™)
Spectrometer manual, part number 1930081, TSI Incorporated

Model 3936 Scanning Mobility Particle Sizer™ (SMPS™)
Spectrometer manual, part number 1933796, TSI Incorporated

Model 3980C macroIMS™ Macroion Mobility Spectrometer
manual, part number 1930110, TSI Incorporated

Model 390069 Data Merge Software Module manual, part
number 1930074, TSI Incorporated

Series 3080 Electrostatic Classifiers manual, part number
1933792, TSI Incorporated

Getting Help

To obtain assistance for this software or to submit suggestions,
please contact Particle Instruments:

TSI Incorporated

500 Cardigan Road

Shoreview, MN 55126 USA

Fax: (651) 490-3824

Telephone: 1-800-874-2811 (USA) or (651) 490-2811
E-mail: technical.service@tsi.com

Xi


mailto:technical.service@tsi.com�

Xii

Submitting Comments

TSI values your comments and suggestions on this manual. Please
use the comment sheet, on the last page of this manual, to send us
your opinion on the manual’s usability, to suggest specific
improvements, or to report any technical errors.

If the comment sheet has already been used, mail or fax your
comments on another sheet of paper to:

TSI Incorporated

Particle Instruments

500 Cardigan Road

Shoreview, MN 55126

Fax: (651) 490-3824

E-mail Address: particle@tsi.com

Aerosol Instrument Manager® Software for SMPS™ Spectrometer
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CHAPTER 1
Introduction

The Aerosol Instrument Manager” software is used to collect sample
data from a spectrometer and store the sample data in files. You
can use the software to display data in graphs and tables, or view
statistical information. You can print graphs and tables with the
software, and you can export data for use in other applications,
including a Microsoft® Access® database.

There are a number of ways to navigate within the program. These
include selecting items from the main menus, selecting icons from
the toolbar, and selecting items from submenus (which you access
by right-clicking the mouse button). Specific instructions are
provided in the following chapters.

The Aerosol Instrument Manager” software is designed to be used
with a variety of different TSI spectrometers and sensors.
Aerodynamic Particle Sizer® (APS™) Spectrometers

Scanning Mobility Particle Sizer™ (SMPS™) Spectrometers
Condensation Particle Counters (CPCs)

Electrical Aerosol Detectors (EADs)

Aerosol Electrometers

000000

Electrostatic Classifiers

This manual covers the use of the Aerosol Instrument Manager®
software with TSI Scanning Mobility Particle Sizer™ (SMPS™)
Spectrometers only. For information about software operation with
other TSI spectrometers and sensors, refer to the appropriate
manual.

This manual assumes you have Microsoft® Windows® XP,
Windows Vista®, or Windows 7 (32-bit) on your computer and that
you are familiar with how Windows® works. If you are not familiar
with Windows® operation system, please refer to the information
that came with it before you load and use this program.

“Microsoft, Windows, and Windows Vista are registered trademarks of Microsoft Corporation.
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How This Manual is Organized

This manual describes the Aerosol Instrument Manager® software
and includes information such as:

Q

Q

Requirements for loading and running the software.

The installation procedure that loads the program onto your
computer.

A “Getting Started” chapter that introduces basic software
operation.

“How to...” information for using the program to operate and
collect data with the SMPS™ spectrometer.

Descriptions of the menus and menu items which are valid
when collecting data with an SMPS™ spectrometer.

Appendixes that provide reference information associated with
program operation.

Notations/Conventions Used in This

Manual

1-2

Throughout this manual when reference is made to “Windows,”
it implies either Windows® XP, Windows Vista®, or Windows 7
operating system.

Bold face type is used to indicate that you should perform the
indicated action. For example “select the File menu” means that
you should use the mouse and click on the menu called File.

When instructions direct you to select items from a menu, a
vertical bar (1) is used to separate the items you should select.
For example, “select File | Properties | Scheduling” means you
should click on the File menu, then select the Properties item,
and then select the Scheduling tab.

The term “active window” is used to refer to the window that is
open on the desktop and is in focus. To verify which window is
active, select the Window menu and note which item has a
checkmark by it. You can make a window active by moving the
pointer to that window and clicking the mouse button.

Aerosol Instrument Manager® Software for SMPS™ Spectrometer



CHAPTER 2
Installing the Software

This chapter describes the installation requirements for the Aerosol
Instrument Manager® software and the installation procedure.

Note: If the Data Merge software, is being used with the Aerosol
Instrument Manager® software, it should be installed as
listed:

C:\Program Files\tsi\Data Merge Software
Module\DataMerge.exe

When installed correctly, Aerosol Instrument Manager®
software activates the data merge software and the Data
Merge icon appears ( ik, ) on the main toolbar. For more
information on the Data Merge software, please refer to the
Model 390069 Data Merge Software Module manual

(P/N 1930074).

Installation Requirements

To use this software we recommend a personal computer with the
following minimum features, components, and software:

O A Pentium® 586 processor or higher.

O A SVGA color monitor.

O Microsoft Windows® XP, Windows Vista®, or Windows 7 (32-bit)
operating system.

O A hard drive large enough to accommodate Windows®, the
Aerosol Instrument Manager® software, and data files.

Note: The amount of disk space required depends on the number
of samples you collect, the amount of information collected,
and the sampling period. After you have collected a
number of samples, you may want to look at the file size to
estimate how much storage space you will be using.

O A CD-ROM drive.

“Pentium is a registered trademark of Intel Corporation.
*Microsoft” Windows" are registered trademarks of Microsoft Corporation.
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256 MB or more of random access memory (RAM).
A mouse.

An RS-232 serial interface port or a USB port for each
instrument connected (in addition to the one that may be
required for the mouse). USB connections are available for
Series 3770 CPCs and Series 3780 particle counters.

Note: Three Series 3770 CPCs can be connected using USB to
collect data simultaneously.

A Microsoft Windows® operating system-compatible printer is
optional.

Installation

2-2

Install the Aerosol Instrument Manager® software as follows:

1.

Shut down (exit) all programs/applications on the Windows”
desktop.

With the computer on and Windows" operating system running,
insert the Aerosol Instrument Manager® CD-ROM in your CD
drive to run the autorun.exe from the CD.

a. If AutoPlay is enabled on your PC, the setup program will
begin automatically and the introduction screen is displayed
on the Windows® desktop.

b. If AutoPlay is not enabled, select Run from the Start menu
and type: D:\autorun (where D is the letter corresponding
to your CD drive) in the Open box and press OK.

Follow the instructions as the setup program runs. When setup
is complete, you should read the readme.htm file. This file
contains information that could not be included in this manual.
If you decide not to read the file immediately, you can access
the file later using a browser such as Windows"® Internet
Explorer” browser.

When the installation program finishes, remove the CD-ROM
and store the CD in a safe place for later use.

The setup program creates a directory (folder) called “Aerosol
Instrument Manager” on your hard disk (assuming you accepted
the default directory name). The directory contains the required
program files and sample data files.

The setup program also creates a new item in the Start Menu called
“TSI” and an icon for the Aerosol Instrument Manager” software.

Note: Before creating a TSI menu item, the setup program checks for

an existing one. If one is present, it adds the icon only.

Aerosol Instrument Manager® Software for SMPS™ Spectrometer



CHAPTER 3

Getting Started

Aerosol Instrument Manager”® software version 8.2 includes support
for the Model 3080 Electrostatic Classifier. If the classifier is
connected to the computer via an RS-232 cable, the software will
read temperature and pressure from the classifier and use those
values to calculate gas viscosity and mean free path. If the software
is not connected to the classifier, the reference values entered on
the SMPS™ Properties dialog will be used. The software will also set
the sheath flow rate and bypass flow rate in the classifier to the
values selected on the SMPS™ Properties dialog.

This chapter is designed to give you an introduction to the basic
operation of the Aerosol Instrument Manager® software. Using it,
you will:

O Start the program.

O Open an existing file (from the example files provided with the
program).

Change data display.

Display another sample in the same file.

Playback (review) data samples in a “slide show” fashion.
Select a data hot spot.

Delete/Undelete samples.

Zoom in and zoom out on data in a graph.

Print information displayed on the desktop.

Export data to a file.

Arrange open windows.

0o 0 0o 00000 0 D

Quit the program.

Start the Prog

Fam

To start the program, proceed as follows:
From the Windows® desktop, using the mouse, double-click the

Aerosol Instrument Manager® icon or press the Start menu and
then select Programs | TSI| Aerosol Instrument Manager.

3-1



The Aerosol Instrument Manager® desktop appears as shown in
Figure 3-1.
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Figure 3-1
The Aerosol Instrument Manager® Desktop and Selected Displays

Open an Existing File

1. Select File|Open..or El on the toolbar. The “Open Instrument
Associated Data Files” window opens.

2. When the “Open Instrument Associated Data Files” window
appears, select the correct extension for the file you want to
open in the “Files of type” box. For example, for an SMPS™
spectrometer, the file extension is .s80.

If necessary, browse for the drive/directory where data files are
stored. (Example files are included with the program and were
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installed in the Aerosol Instrument Manager® folder when the
program was installed.)

3. Select the data file that you want to open and click Open. At
least two windows open on the desktop: a window containing a
graph of the sample data, and the Samples List window
(Figure 3-1).

Note: If the file has been opened before, it may display more
than one graph and/or table. The program remembers the
windows that were open on the desktop when you last
closed the file and reopens them when you access the file
again. If the file contains a sequence of samples, you will
be asked if you want to open all the files or just the one
you originally chose. See Appendix E for information about
sequence files.

The Samples List window opens whenever you open a
data file and remains open on the desktop as long as the
data file is open. Closing the Samples List window closes
the data file (and all its open windows).

Change Data Display

For most spectrometers, you can view data in tables or graphs and
in several different formats (for example, SMPS™ data can be
viewed by raw counts, concentration, and so on). The following
procedure provides an example of how you can change data
display.
1. Open one of the sample SMPS™ files as described in “Open an
Existing File”.
With the graph window active on the desktop, point and the
mouse on the graph, right-click the mouse to display various

viewing options. Refer to “Format Menu” in Chapter 4 for
detailed explanations.

Notice the change in how data is displayed. (A checkmark next
to one of the menu items means that a window for that selection
is already open on the desktop. If you select a menu item that is
already checked, the window containing that graph or table is
brought to the top of the desktop and becomes the active
window.)

2. Experiment with other views by making other windows active
and selecting other options from the View menu to see how
your selections change the data display.
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Display Another Sample in the Same File

1. To display another sample in an open file, select the ﬂ[ icon (go
forward one sample) from the toolbar. The data for the next
sample of the currently active file replaces the data in all the
open windows.

2. You can continue to step through the samples by selecting the
ﬂ[ icon until you reach the last sample.

The sample currently displayed in the open window is
highlighted in the Samples List window.

Another method of changing the sample that is displayed in the
open windows on the desktop is by selecting the icon for that
sample from the active Samples List window.

You can use the following icons to display other samples:
First Sample. Advance to the first sample.
Previous Sample. Go back to the previous sample.

Next Sample. Advance to the next sample.

EE 2

Last Sample. Advance to the last sample.

Playback (Review) Data Samples

You can display sample graphs and tables in a slide show format
(to preview sample results or compare sample differences) as
follows:

1. From the Samples List window, select the samples you want to
play back using one of the following actions:

Select Sample | Select All, to play back all samples.
or

Select individual samples using the mouse and the Ctrl key to
highlight those samples you want to see. (You must select at
least two samples.)

or

Select a group of samples by holding down the left mouse
button and moving the mouse to “rubber band” (outline) the
samples you want to select.

Note: The Playback menu items and toolbar icons are only
enabled when the Samples view is the active view.
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2. When you have selected the samples you want to view, select
Playback | Play. The setup box shown in Figure 3-2 appears.

Playback Setup

Sample Viewing Time

(" full speed Play Once

(" 05 seconds
Play Continuous

il

(" 2.5 seconds Cancel

(" 5 geconds

Figure 3-2
Playback Setup Dialog Box

3. Select the sample viewing time and whether you want the
samples displayed once or continuously. Playback begins
immediately. For better viewing, it may be necessary to
minimize the Samples List window.

4. Playback can be paused at any time by selecting
Playback | Pause. Select Playback | Play to continue playback
where you left off. Playback can be stopped at any time by
selecting Playback | Stop. When playback is stopped, you
cannot restart it. Use Playback |Pause and Playback | Play if
you want to stop and start playback.

You can also control playback by using icons on the toolbar. The
icons perform the following operations:

| Stop. Stop playback.
m Pause. Pause playback on current sample.

|L[ Start. Start playback or restart playback.
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Select a Data Hot Spot

When a graph is open on the desktop, you can find the values of a
data point as follows:

1. Position the pointer on the bar, line, or peak (depending on the
type of graph that is active). The pointer becomes a pointing
hand.

2. Press the left mouse button to display the values. Figure 3-3
shows how the data values would be displayed for an SMPS™
spectrometer (diameter and number concentration).

40.0

7.58e+04

“““| N “““““||||||||||""||||||I||I..n.4....1...L |
100

1000

0.0- ol
1 10

Diameter (nm)

Figure 3-3
Use the Mouse to Directly View Data Values

Tip: After you have a data hot spot selected, use the arrow keys or
the “>*“ and “<* keys to move the cursor right or left (from one
value to the next), or grab the vertical bar and drag it to
another location. Refer to Appendix B for a list of other keys or
key combinations you can use to navigate and perform
operations without using the mouse.

Delete/Undelete Samples

3-6

To delete samples from a file, you must first mark them for deletion
and then either Close or Save the file. The following procedures will
permanently delete samples from a file:

Mark samples for deletion as follows:

1. Select the sample you want to delete from the Samples List
window (you can select multiple samples).
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2. Select Sample |Delete/Undelete Sample or ¥ on the toolbar.

The samples will be shown as “Deleted.” However, they will not
be permanently removed from the file until you Close or Save
the file.

Save the file and permanently delete all samples marked for
deletion:

1.

With at least one sample marked for deletion in the active file,
select File | Save. You will get a message stating: “Some samples
have been marked for deletion. Do you want them permanently
removed?” Click Yes to remove them or No to keep them.

Select Yes. The samples marked for deletion are permanently
deleted.

Note: If you attempt to close all the windows for the file or exit the

program without saving the file, you will get a message asking
whether you want to save changes to the file. Respond Yes
and you will get the same message stating “Some samples
have been marked for deletion. Do you want them
permanently removed?” Respond Yes to delete the marked
samples and No to close the file without deleting them.

Zoom In and Out on Data in a Graph

You can zoom in on data displayed in a graph as follows:

1.

Use the mouse to position the cursor (pointer) at one corner of
the area you want enlarged.

Press down on the left mouse button and drag the mouse to the
opposite corner of the data you want enlarged.

Release the left mouse button. The area you selected is
enlarged.

You can continue to zoom further by repeating steps 1
through 3.

UHD0

To Unzoom, select Format | Undo Zoom or _£ | on the toolbar. The
enlarged area is returned to normal view.
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Print Information Displayed on the
Desktop
You can print the information displayed in the active window on the
desktop as follows (you must have a printer properly installed):
1. With a graph or table window active on the desktop, select
File | Print Preview or @

2. Review that what you see in the print preview window is what
you want to print (an example is shown in Figure 3-4), and then
select Print from the Preview box. The contents of the window
are sent to your printer.

You can immediately print a window without previewing it by
selecting File | Print or |§ from the toolbar.

Size Data Graph [Outdoor Alr 580]

| | Zoomin

Tl - Eraraing Nability Parficle Sl

Figure 3-4
Print Preview
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Export Data to a File

You can export data from an SMPS™ Aerosol Instrument Manager®
file (either a single sample of the file or multiple samples of the file)

for use in another program such as Microsoft Excel® or Microsoft

Access® database. You can export data either manually or

automatically. Refer to Chapter 4 for information on exporting

SMPS™ data to the database.

To Export Data to a File Manually

To export data to be used in another program:

1. Select the sample or samples to be exported as follows:

To export data from a single sample, display the sample data in
an active window on the desktop.

To export data from multiple samples, select (highlight) the
samples you want to export from the Samples List window.

2. Select File | Export to File. An Export Parameters dialog box

appears as shown in Figure 3-5.

Export Parameters

Data Twvpes

dwidlogDp
Concentration (i)
% concentration
cumulative conc.
cumulative 25 conc.
Raw Counts

Delirmiter
® Tab

Qrientation
@ Column

[ Raw Data

HNumber
.

CH )

(" Comma

(" Row

Diarneter Surface “olume

r

CIC I

.

CIC I

(" Semicolon

Cancel

.

CIC I

i

200 e e D

x|

Figure 3-5

The Export Parameters Box.
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3. Select the type of data you want to export as well as the format
you want to export the data in.

Data can be exported in a delimited text file and you can select
from three delimiters: tab, comma, or semicolon. The
orientation of data can be either column or row.

4. Click OK.

5. Select the drive/directory you want to export the data to and
enter a filename. The system automatically adds the .txt file
extension.

6. Click Save.

Figure 3-6 illustrates how an exported *.txt file is formatted for
an SMPS™ spectrometer.

E Outdoor Alr.txt - Hotepad

Cile Cdt Foomal Yiew el

canple File C:yProgram Files\TsI\Aeroso] Instrument Manager\Cutdoor Air.580 =
classifier Model 3080

DA Mode 3081

DA, Inmer R.'HI‘IIJEI[EIHE 0.00937

DA Outer Radius{cm 0, 01961

DA characteristic Lemgth{em) 0.44369
CPC Mode 3775 High Flow

Gas Viscosity I[ltq.-'{m*i-}g 1.8203e-005

Maan Fres Path (m) 6. 008

Channels/Decade 64

Multiple charge Correction FALSE

units  dw/dlogDp

‘waight Number

sample # 2 3 4 4

Dats 03/18 /02 03 /18,02 03/18/02 0371802
Start Time 15:20:03 15:25:03 15:30:04
Oiameter Hidpoint
14.1  22433.2 28021,

15:35:04
2L759.6 23654

2
14.6 20148.9 28690.6 17062 18058, 2
15.1 2660%.3 30700.5 22387 25014.3
15,7 29G58.2 R3A7H.4 26652.1 26236.8
16.3 33785.9 35267.7 25740.2 29427.8
16.8  38305.5 43038 % 283I2F  I9453.9
17.5 A47076.2 S1370.4 37748 I6575.5
15.1 41567.5 S7568.1 38457.5 39471.2
15.8 A4T7356.2 G3I6T7.T7 4TE4T.8 41290.9 i

Figure 3-6
A Sample Export File for an SMPS™ Spectrometer
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To Export Data to a File Automatically

To export data automatically to a file for use in another program
(such as Microsoft® Excel®):

1. Establish a connection to the spectrometer by choosing
File INew or File| Open.

2. If not already connected, select Run|Connect to the CPC.

Note: Perform the following step before you start collecting the
data.

3. Select RunlAuto Export to File. Select the type of data you
want to export as well as the format you want to export the data
in, using the Export Parameters dialog box (see Figure 3-5 on
previous page).

4. Select RunlStart Data Collection. The data is exported to the
file as it is collected.

(continued on next page)

¢ Microsoft and Excel are registered trademarks of Microsoft Corporation.
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Arrange Open Windows

3-12

When you have several windows open on the desktop it is helpful to
arrange them for easier viewing.

To arrange windows, select an item from the Window menu. You
can arrange windows on your desktop horizontally, vertically, have
them cascade, or arrange them in a predetermined auto-fit 2-pane
or 4-pane layout. Refer to your Windows® documentation for
examples and more information for tile horizontal, tile vertical, and
cascade layouts. Press the ﬂ button (or Ctrl+L) in the toolbar for
the four-pane layout or press the =& button (or Ctrl+K) for the two-

pane layout as shown in Figure 3-7 for a spectrometer file.
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O Bah Davbich Fosal fee Jeepl  Wrdee  Hee

[wf- 3§

L e

I DM X A &

Filre Data Ciaph [Seaffum Chlarite e Tew 5350]

2.0
1.8+
1.6+
s 14+
1.2+
1.0-
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Figure 3-7
Two-Pane Layout of an SMPS™ File

All of the program windows that are currently open on the desktop
are listed at the bottom of the Window menu under the Close All
item. To make a window active and bring it to the top of all
windows, select the name of the window from the list of open
windows.
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Quit the Program

To end the program, select File | Exit. All windows and files open on
the desktop are closed. If you have made changes to a file and have
not yet saved it, you will be prompted to do so.
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CHAPTER 4

SMPS™ Spectrometer
Procedures

Before using the information in this chapter, read Chapter 3. That
chapter provides getting started information to help you
understand the basics of how the program works. It also includes
procedures common to all spectrometers.

The subsections of this chapter provide:

0 “How To...” information for: collecting sample data with an
SMPS™ spectrometer, setting up properties for an SMPS™
spectrometer, appending sample data to an existing SMPS™
file, exporting SMPS™ data to a Microsoft Access® database.

O A description of all menus and menu items available when
using the SMPS™ spectrometer or viewing SMPS™ data files.

How To Collect Sample Data

There are three steps for collecting sample data.

O Step A: Open a new SMPS™ file

QO Step B: Review/change parameters

O Step C: Start data collection

Note: You can append SMPS™ sample data to an existing file. Refer
to “Append Sample Data to an Existing SMPS™ File” below.

Before you begin, make certain you have connected the CPC to the
computer and the spectrometer is running. Refer to the appropriate
hardware instruction manual if necessary.

Step A: Open a New SMPS™ File
To open a new SMPS™ File:

1. Select File | New or E[ on the toolbar. The New Instrument and
Associated Data File dialog box (Figure 4-1) opens on your
desktop.
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Mewr Instrument and Associated Data File

D

My Recent
Documents

Desktop

=

My Documents

9

Look jn: | |5 Aerosal Instrument b anager

|} Outdoor A, SB0:
|| PsL. 580
M Sodiun Chlaride_low Flow, 580

by Computer
My Network — File pame: A1 1 = Open |
Places
Files of type: |SMP'S Data file [*.580] Bl Cancel
MNOTE: 'Files of type' Selects the Instrument Model and Associated File Extenzsion. Enter a
MNew File Name in File name’. The File Estension Wil be Added Automatically
Figure 4-1

Select an SMPS™ Filename When you Open a New File

Note: The following step must be performed before you start
collecting data.

2. Select a filename (and, optionally, a location other than the
Aerosol Instrument Manager® folder). The default name is
“AIM1” for the first file you open, “AIM2” for the second file you
open and so on.

You can accept the default name or enter any name you choose.

3. Verify that the “Files of Type” box indicates the correct
extension for the spectrometer you are using (.S80 for an
SMPS™ spectrometer). You do not need to enter an extension in
the filename box. It is assigned automatically.

4. Click the Open button.
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5. If the Model 3080 Classifier is currently selected and auto-
connect is selected, the software will attempt to connect to the
classifier at this time, first using the current default COM port
selection for this instrument and next trying the other available
Com ports. If the attempt to connect fails, the CLASSIFIER
Model 3080 Communications dialog will appear allowing you to
select the COM port (Figure 4-2). This is separate from the
dialog that allows you to select the COM port for the CPC. That
dialog is found on the Communications page of the Properties
dialog

6. You can select the correct port by double-clicking on the port
name (e.g., COM1), or click the Cancel button if not using the
Model 3080 Classifier, or if planning to run the software without
connecting to the classifier (Figure 4-2). In the latter case, you
will need to set the flow and other values on the classifier
manually and the software will use reference gas values from
the Properties dialog rather than values read from the classifier.

CLASSIFIER Model 3080 Communications E|

Ports available For Classifier:

[IF available, double-dlick on ane of the ports o connect, ]

Port Instrument Yersion Status

Coma

oK | Cancel ‘

Figure 4-2
CLASSIFIER Model 3080 Communications Port Selection Screen

Note: The Communications page on the Properties dialog is _for
selecting a port for connection to the Condensation Particle
Counter, not the Classifier. You can use the menu to
connect to the Model 3080 Classifier, by selecting Run |
Connect to Classifier 3080.

7. If you open a new file and the SMPS™ Properties dialog is not
complete (this can occur the first time you open a new file for
the SMPS™ spectrometer or after you have selected File | Clear
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Settings) the SMPS™ Properties dialog box appears and you
must complete it and press OK to proceed.

8. If you get the following error message when opening a New file,
press the OK button to open the Properties dialog box
(Figure 4-3).
Aerosol Instrument Manager g‘

'T IUnable to establish a connection to the CPC,
[ ]

Please check that the instrument is connected, turned on,
that wou don't already have another connection open,
or that another device is not already using this port.

Figure 4-3
Unable to Establish a Connection to the CPC Error Message

9.

Verify the connection to the spectrometer and make certain the
spectrometer is turned on. To verify the COM or USB Port
setting:

a. Check that the correct communications port was selected
during program setup by double-clicking on the port listed
under the Communications Tab.

b. If the test is unsuccessful, select another port and double
click on the port again.

Note: The new Series 3770 Condensation Particle Counters
have USB ports to connect to the computer. The
Series 3780 Water-based Condensation Particle
Counters also have USB ports but they are treated as
serial ports using a USB driver. See instrument
manual for details.

c. Once the correct port is selected, select OK to return to the
desktop and the active window.

Step B: Review/Change/Setup SMPS™ Properties

Before you begin sampling, you may want to review the Properties
dialog to verify correct start time, hardware settings, and so on.

1.

Select File | Properties or Run | Properties (or Ctrl+R) and
select the various tabs to review the settings. Refer to “Setting
Up Properties for an SMPS™ Spectrometer” for how to change
settings.

If the software is connected to the Model 3080 Classifier, the
temperature and pressure read from the classifier are used to
calculate mean free path and gas viscosity and these values are
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used in calculations. If not connected to the Model 3080
Classifier, the reference gas values from the Physical Properties
page of the SMPS™ Properties dialog are used instead.

3. Once you have set up the parameters or verified they are
correct, close the Properties dialog box and continue with
Step C, “Start Data Collection.”

4. At this time, if connected to the Model 3080 Classifier, the
software will set the sheath flow rate and bypass flow rate in the
classifier to the values selected on the properties dialog. It will
also set the sheath flow mode to the appropriate value (dual or
single blower) based on the flow selections, and will set voltage
mode to analog. The software will also set the CPC flow rate to
the selected high or low value when the CPC has two flow
modes.

Step C: Start Data Collection

After you have completed the properties dialog, data collection
begins at the “Start At Time” you set on the Properties dialog or
immediately after you do one of the following:

O Select Run|Start Data Collection using the menus.
O Click El on the toolbar.
O Double-click the New Sample icon in the Samples List window.

If the model 3080 classifier has been selected, the software will read
the sheath temperature and absolute pressure from the classifier
and will wait for OK status from the classifier before it starts to
collect data. The software displays the temperature and pressure at
the bottom of the graph and tables. If the software is not connected
to the classifier or unable to read from it, there will be dashed lines
at the bottom of the graph and tables in place of the temperature
and pressure.

When the program begins collecting sample data, the data is
displayed in the windows that are open on the desktop.

As each sample finishes, the data for the sample is stored and a
new sample begins. When the last sample finishes, sampling stops,
but the windows remain open.

To stop data collection before all the samples are collected, do one
of the following;:

U Select Run|Finish Current Sample. Data collection stops after

the current sample finishes.
or
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U Select Run|Abort Current Sample or M on the toolbar to stop
data collection immediately. When you select Abort Current
Sample, the data collected for the current incomplete sample is
discarded.

Setting Up Properties for an SMPS™

Spectrometer

4-6

To access the Properties dialog box for an SMPS™ spectrometer,
select File | Properties or Run | Properties (or Ctrl+R) when an
SMPS™ file is active on the desktop.

The properties displayed in the Properties dialog box are either:
O The initial default properties as set by TSI or

0 The default properties set by a user who selected File | Save
Properties as Default after making changes to the Properties
dialog box or changed the settings and had the File | Save
Properties on Exit menu item checked.

The Properties dialog box contains four tabs: Hardware Settings,
Scheduling, Physical Properties, and Communications. Each is
described below.

If this is the first time you have accessed the Properties dialog, you
will need to set up the parameters before continuing. If you have set
up the properties before, verify they are correct and press OK. The
following paragraphs describe the settings for each tab of the
Properties dialog box.

Note: If you want to use the same settings the next time you open a
new file, remember to either select File| Save Settings As
Default or have the Filel Save Settings on Exit menu item
checked after you have completed the Properties dialog. Once
your settings have been saved, the properties dialog will not
open automatically when you open a neuw file.

Some properties of an existing sample can be changed through
the Properties dialog. If a common property of multiple samples
needs to be changed, you can first select the samples and then
access the Properties dialog to change the property of all the
selected samples.

SMPS™ Hardware Settings Tab

Use the Hardware Settings tab to specify hardware settings for the
SMPS™ spectrometer. The fields on the tab vary depending on the
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model of classifier and the Differential Mobility Analyzer (DMA)
model of your SMPS™ spectrometer. Figure 4-4 illustrates the tab
for the Model 3080 Classifier with a 3085 Nano DMA. Table 4-1
describes each of the fields/settings.

You cannot close the Properties dialog or select any of the other
tabs until all values have been set on the Hardware Setting tab.

SMPS Properties - New Sample El

Hardware Settings l Scheduling] Physical F'mperties]

CPC Model and Flow Rate

" 3010 (7 3025 high 3776 low " 37865 " 3788 high
7 3022 low " 3772 (v 3776 high 1 3787 low

" 3022 high (™ 3775 low " 3782 " 3787 high

7 3025 low " 3778 hgh 3785 " 3788 low

Classifier Model [ibd

73071+ 3080

v Auto-connect

H

7308 0 3085 O Custom  HY Polanty: e] -

D& Flowe B ate [lpm) Impactor Type
Sheath [15.00 aeroszal [1.50 " 0.0457 cm td (g] |0.34
" 0.0502 cr
Optiohal Bypass Flow o 0 tiz) (0.2
Bypaszs flow requires . cm
i g DE0
Bypasz |0.0 zpecial fow plumbing. & Mane () 1000

See 3080 manual.

Size Range Bounds [Diameter]

Lower [ar) | 1.98 - Upper [ar) | 54.9 - Set to Max Range
Waltage Flange [v] Scan Time [g]
10 JEE IUp |120 Fetrace |15

0K | Cahcel

Figure 4-4
Hardware Settings Tab of the Properties Dialog

Table 4-1
Descriptions for SMPS™ Hardware Settings Tab
Setting Description

Classifier Model Select the model of Electrostatic Classifier used in
the system.
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Setting

Description

Auto-connect

Check this box if you want the software to
automatically connect to the classifier by searching
the ports to find the instrument. You can also select
Run | Connect to Classifier from the menu.

DMA Model

Select the model of Differential Mobility Analyzer
used in the system.

HV Polarity

This is the polarity of the high voltage controller
which is installed on your 3080 classifier. A
negative high voltage controller is the default
configuration and is used to measure positively-
charged particles with your SMPS™ spectrometer,
Your selection must match the polarity of the high
voltage controller physically installed in your 3080.
According to your selection, the Aerosol Instrument
Manager® software will read the appropriate charge
correction file (ChargeAim.dat for negative high
voltage controller or ChargePos.dat for positive high
voltage controller) and apply this to your data.
Note: Do not change this setting without physically
changing the high voltage controller installed in your
3080! Refer to the 3080 manual on how to order a
positive high voltage controller and how to install it.

Impactor Type

Select the type of impactor used in the system.

CPC Model and
Flow Rate

Select the Condensation Particle Counter used in the
system and the high or low flow rate for
Condensation Particle Counter models 3022A,
3025A, 3775, and 3776 and for Water-based
Condensation Particle Counter Models 3787 and
3788.

Each model of Condensation Particle Counter differs
in concentration range, sample flow rate, and other
specifications. To avoid large errors in measured
particle distributions, make sure the Condensation
Particle Counter selected matches the one in your
SMPS™ system.

Inlet Flow Rate
(L/min)

This option only appears when a Model 3022A
Condensation Particle Counter with a high flow rate
is selected. Enter the inlet flow rate of the
Condensation Particle Counter. The value must be in
the range 1 to 2.

Aerosol Flow
Rate (L/min)

Enter the aerosol flow rate for the DMA. The value
should be in the range .2 to 2.0.

Sheath Flow
Rate (L/min)

Enter the sheath flow rate for the DMA. The value
should be in the range 2 to 20.

Bypass Flow

Optional bypass flow in L/min. The use of bypass
flow requires special flow plumbing. See the
Classifier Model 3080 manual to set up the flow
plumbing. If not using bypass flow, set this value to
0.0.

td (s)

td is the time for the aerosol to flow through the
sample column of the classifier and the connection
tubing between the DMA and the Condensation
Particle Counter which is assumed to be 10 inches
long. Although you can enter a value for td (O to 10
seconds), it is recommended that you use the value
calculated from the hardware settings.
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Setting

Description

tf (s)

The tab shows the tf (in seconds) of your SMPS™
spectrometer. tf is the calculated time for the aerosol
to flow through the sample column of the classifier.
The calculation of tf is based on the classifier’s
sheath air flow rate, the polydisperse aerosol flow
rate, and the geometry of the classifier.

D50 (nm)

The tab shows the D, cut point for the impactor at
the inlet of your SMPS™ spectrometer. The D, cut
point is the 50% cut-point diameter of the impactor.
It changes if you change the size of the impactor or
the polydisperse aerosol flow rate.

Size Range
Bounds
(Diameter)

Enter the minimum and maximum size range to be
sampled using the pull-down lists. The minimum
and maximum size limits are determined by the
DMA flow rates of your system. You can select the
particle diameter range to view with this option, but
choose new flow rates will change the available
particle diameter sampling range.

Set to Max Range

Select this button to automatically set the Size
Range Bounds to the maximum range based on the
current DMA and flow settings. Calculation is based
on Max and Min voltages (vmin = 10 and vmax =
10,000 for the 3080 classifier; vimin = 10 and vmax
=11,000 for the 3071 classifier).

Voltage Range

Displays the voltage range based on the size range
selection.

Scan Time

Enter the Scan Up and Scan Retrace times (in
seconds).

Scan Up time is the period during which the
classifier center rod voltage is exponentially
increasing in magnitude. Size distribution data is
sampled during Scan Up. The Scan Up range is 20
to 300.

At the start of the Scan Retrace time period, the
classifier voltage is reset to its initial voltage. The
Scan Retrace range is 10 to 300.

Scan time selection depends on several factors
including: desired particle size accuracy, CPC
response time, flow rates, and particle size range.
Generally, longer scan times provide better data,
while decreasing the scan time results in a decrease
of the particle size accuracy of the SMPS™ system.
Accuracy decreases for three reasons: (1) smearing
effects caused by the response time of the CPC, (2)
the increased dependence on the exact value of td,
and (3) the increase in granularity of the data.
Typically, a 120-second Up Scan and a 15-second
Retrace Scan (default values) provide adequate
accuracy and are a good starting point. Use a
shorter scan time (30 seconds) for measurements in
which the aerosol changes substantially during the
sample period. Use a longer scan time for
measurements in which there is a low concentration
and a high particle size accuracy is desired.

Down Scan First

Select this box to perform a down (retrace) scan first.
The box is available only for the Classifier Model
3071.
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Setting Description

Cylindrical DMA | These options are available only if you select the
Measurements Custom DMA model. Enter the dimensions for your
(cm) DMA.

Cylindrical DMA Measurements [cm)

Length |44 369 Inher Radius (0937 Outer Radius |1.961

. 1 - A |

When the Model 3080 Electrostatic Classifier is selected and
connected, the software reads the sheath temperature and the
absolute pressure from the instrument and uses those values to
calculate gas viscosity and mean free path, which are used in other
calculations. If unable to read temperature and pressure from the
instrument, the reference gas viscosity and mean free path from the
properties dialog are used instead. The flow rates are not read from
the classifier when the properties dialog is opened so the current
flow values from the instrument are not displayed in the properties
dialog. After you close the properties dialog the software sets the
sheath flow and bypass flow rates in the Model 3080 Classifier to
the values selected on the properties dialog. It also sets the CPC
flow rate to the high or low value selected if the CPC has two flow
rate options.

SMPS™ Scheduling Tab
Use the Scheduling tab to select:

a

a
a
a

The number of scans per sample
The number of samples to be taken
How often samples are collected

The start time for the first sample

Figure 4-5 shows the Scheduling tab of the Properties dialog.
Table 4-2 provides a description of each parameter.
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Figure 4-5

Scheduling Tab of the Properties Dialog for an SMPS™ Spectrometer

Table 4-2
Descriptions for the SMPS™ Scheduling Tab
Parameter Description
Scan Up Displays the value selected in the Hardware
Settings tab.
Retrace Displays the value selected in the Hardware

Settings tab.

Scans per Sample

Enter the number of scans you want to take per
sample.

Number of Samples

This is the total number of samples you want to
collect. The maximum value allowed is 65535.

Total Sample Time

This field is calculated by the software and shows
the total sample time based on the values you
entered in the previous boxes. The value is
displayed in hours, minutes, and seconds.

Scheduled

Select Only Once to collect one set of samples. For
continuous monitoring, select Repeat Every and
then select the hours and minutes between
samples. The intersample time should be longer
than the Total Sample Time to include the
overhead time that is needed for file handling.
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Parameter Description

Start At Time If you don’t check this box, sampling begins as
soon as you select Start Data Collection.

If you want to select a start time, check the box
and enter the clock time at which you want
sampling to begin. The program uses a 12-hour or
24-hour clock, depending on how your PC is set
up. If your PC is set up to use a 12-hour clock,
you must indicate if the time is am or pm by
unchecking the PM box or checking the PM box.
The reference time for the program is the time at
which your computer is set.

Trigger File Specify a file name only (not a complete pathname)
of a text file. This file when updated in the same
directory where Aerosol Instrument Manager is
installed, will act as a trigger to start SMPS™
sampling. For example, specify “trigger.txt” in the
edit box. When you wish to trigger the sampling to
begin, create or update the file trigger.txt in the
Aerosol Instrument Manager directory (Note: the

contents of this file are not read).

Files of Sample Sessions That Run Past Midnight

The files for sample sessions that run past midnight are handled
differently than those that start and stop on the same date. In this
case a sequence of files is created, with each file in the sequence
given a unique filename identifying its proper order. Appendix E
provides a complete description of sequence files including how to
access a file that is part of a sequence.

SMPS™ Physical Properties Tab

Use the Physical Properties tab (Figure 4-6) to specify the physical
properties of the sample, provide a title for the sample and enter
any comments about the sample that you want to keep with the
file.
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Table 4-3 describes the fields of the Physical Properties tab.

K

SMPS Properties - New Sample

Hardware Settings] Scheduling Physical Praperties l

Reference Gas Properties

Gas Wiscosity (kg/m®s)] |1.83245e-00% Set bo Defaults for Air ‘
kean Fres Path (m) 6.73e-008 Sutherland Constant (k) [110.4
Temperature [K] 23615 Pressure [kPa) 101.3

Particle Density (g/cc]  [1.2000

Carrection Flags and Y alues
[¥ Multiple Charge Comection Frimary Particle Diameter [hm]: 10.000
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Orientation: % Parallel ¢ Random
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Instrument 10 |3?aa 70000000 0,59,

Comment Saturday, mirimal traffic.
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Figure 4-6
Physical Properties Tab of the SMPS™ Properties Dialog

Table 4-3
Descriptions of the SMPS™ Physical Properties Tab
Field Description
Gas Viscosity Enter the gas viscosity of the gas carrying the

aerosol. The range is less than 1.0 and greater than
0.0. If you are using air, press the Set to Defaults
for Air button.

Caution: Extreme values will cause incorrect results.

Mean Free Path Enter the calculated mean free path between
particles. The range is less than 1.0 and greater than
0.0. If you are using air, pressing the Set to
Defaults for Air button automatically enters the
appropriate value for you.

Caution: Extreme values will cause incorrect results.
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Field

Description

Temperature Enter the temperature (K) of the reference gas.
Sutherland Enter the Sutherland Constant (K).

Constant

Pressure Enter the pressure (kPa) of the reference gas.

Set to Defaults
for Air

Press this button to enter default values for the Gas
Viscosity, Mean Free Path, Temperature, Pressure,
and Sutherland Constant fields.

Particle Density

Enter the particle density (in g/cc) of the aerosol.
This value is used in the calculation of mass
distributions. Default = 1.2 g/cc.

Multiple Charge

If this box is selected (a checkmark indicates it is

Correction selected), it enables a mathematical correction for
particles with multiple charges, see below.
Diffusion If this box is selected (a checkmark indicates it is
Correction selected), it enables a mathematical correction for
diffusion losses.
Enter the carrier gas density. This will be used in the
calculation of the Diffusion Correction.
See below and Appendix G for more information.
Nanoparticle If this box is selected (a checkmark indicates it is
Aggregate selected), it enables a mathematical analysis of

Mobility Analysis | mobility data for nanoparticle aggregates.

Enter the Primary Particle Diameter and the
Orientation. This information will be used in the
calculations.

See below and Appendix H for more information.

Note: The upgrade version of the SMPS™ Software
(AIM3936) does not support this feature.

Title Enter a title to identify the sample.

Instrument ID The instrument ID is a string used to identify the
hardware from which the sample was collected.

Comment Enter any comments you want to keep with the
sample.

Multiple Charge Correction Option

Choose the Multiple Charge Correction check box on the Physical
Properties tab to enable a mathematical correction for particles with
multiple charges. Display options, with the exception of Count,
automatically account for single-charge probability.

Multiple charges on a particle increase its mobility. Since the
program assumes a particle has only one charge, the effect of
multiple charges on a particle allows the particle to be incorrectly
binned into a smaller-sized particle channel. Multiple Charge
Correction, if activated, turns on an internal algorithm that attempts
to correct the sample data for the effects of the multiple charged
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particles. The algorithm performs corrections based on a 64-channel
resolution. The program assumes the impactor removes any particles
larger than its cut-point size (D, ). Therefore, the particles in the size
channel immediately smaller than the impactor cut-point size must
be made up of single-charged particles, because particles with
multiple charges are larger in size than the D, cut point.

The concentration in each size bin is calculated. Once the
concentration for a bin is determined, the program subtracts the
number of multiple-charged particles that would have been
expected to fall in smaller-sized bins. The SMPS™ program then
moves to progressively smaller size channels and continues to
subtract the effect of multiple-charged particles.

The effects of multiple-charged particles are most pronounced for
particles above approximately 100 nm. The efficiency of multiple
charge correction is dependent on several factors and assumptions.
Ideally, the D,, for the impactor should be precisely at the upper
valid measurement range.

The impactor removes particles based on their aerodynamic size. The
program sizes particles based on their electrical mobility, which
closely matches particles' geometric diameter. For particle densities
other than 1.0, the impactor geometric cut point occurs at a point
other than that predicted by the SMPS™ program. If the number of
particles near the D, of the impactor is low, precise cutoff is less
critical. Particles with a size larger than the maximum size set for the
SMPS™ measurement and not removed by the impactor will cause
errors in the correction for multiple charges. Low concentrations
increase the uncertainty of the particle concentration in any channel,
thus reducing the effectiveness of the correction.

View data in both corrected and uncorrected forms to become
familiar with the effect of multiple charges and the limitations of
charge correction.

Diffusion Correction Option

Choose the Diffusion Correction check box on the Physical Properties
tab to enable a mathematical correction for diffusion losses of
particles in their flow path within the SMPS™ system. It is especially
important to use diffusion loss correction when sizing aerosols
smaller than 100 nm, since in this size regime diffusion becomes
increasingly important. Enter the carrier gas density in units of g/cc.
This value will be used in calculations of the diffusion correction.

The diffusion correction can be applied to previously collected data
similar to charge correction. For a detailed discussion on this
subject, please refer to our application note on Diffusion Loss
Correction (Appendix G of this manual).
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Nanoparticle Aggregate Mobility Analysis Option

Choose the Nanoparticle Aggregate Mobility Analysis check box on
the Physical Properties tab to enable a mathematical analysis of
mobility data for nanoparticle aggregates. By default, the software
analyses the mobility raw data for a spherical particle model.
However, not all particles are necessarily spherical. For example,
urban ultrafine particles and particle emissions from combustion
sources such as diesel engines are typically aggregates. The
nanoparticle mobility analysis yields a more accurate estimate of
the number, surface area and volume distributions of nanoparticle
aggregates.

Enter the primary particle diameter, i.e., diameter of the primary
particles that constitutes the aggregate. The assumption here is
that aggregates are composed of primary particles all of which have
the same (known) diameter. Enter the orientation of aggregate
(parallel or random with respect to the electric field). Default is
parallel orientation. Electrical conducting aggregates like diesel
exhaust and most ambient ultrafine particles align parallel to the
electric field due to interaction of induced

The nanoparticle mobility analysis can be applied to previously
collected data similar to charge correction and diffusion correction.
For a detailed discussion on this subject, please refer to our
application note on Nanoparticle Aggregate Mobility Analysis
(Appendix H of this manual).

SMPS™ Communications Tab

The Communications tab, Figure 4-7, lets you set up and test the
communications port. It is only available when you open a new file
or when you select Run | Connect to the CPC on an open file.
Table 4-4 describes the fields and parameters of the
Communications tab.
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Figure 4-7

The Communications Tab of the Properties Dialog

Table 4-4

Descriptions for the Communications Tab

Property

Description

Port

Lists the ports available on your computer system
and lets you select the port that is connected to
the TSI spectrometer.

Double Click on a port to attempt a connection.

Instrument, Serial
No., Version

Instrument Type, Its Serial Number, and the
Instrument Firmware version.

Note: Not all instruments have this information.

Status

Connected—if successfully connected, or blank if
not connected.

Append Sample Data to an Existing SMPS™

File

To append sample data to an existing SMPS™ file:

1. Open the file that you want to append data to.

2. Select Runl|Connect to the CPC.
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If a connection is not found, the Properties dialog opens. Select the
Communications tab to establish a connection with the SMPS™
spectrometer’s CPC.

Once there is a valid CPC connection, the New Sample icon appears
in the Samples List window and the Start Data Collection button
3‘ is enabled on the toolbar. You can then append samples to the
data file (see Step C—Start Data Collection, above).

Export SMPS™ Data to an Access Database

An Access database named “Aerosol Instrument Manager.mdb” is
installed during installation in the program directory. Before you
can export SMPS™ data to this database, however, you must first
set up the database for use.

Note: Microsoft Access® is part of the Microsoft Office software
(beginning with Office 97). To use the database, you must
install Microsoft Access® on your computer. Refer to the
documentation that came with the program for the procedure.

To Set Up the Database
1. From the Windows" Start menu, select Settings.
2. From Settings, select Control Panel.

3. Select the Data Sources (ODBC) icon under Administrative
Tools and double-click on it.

4. On the User DSN tab, select MS Access Database and then
select Add.

5. Select Microsoft Access Driver (*.mdb) from the Create New
Data Source dialog, and then press the Finish button.

6. Type “Aim” in the Data Source Name field on the ODBC
Microsoft Access® Setup dialog then press the Select button.

7. Navigate to the “Aerosol Instrument Manager.mdb” file (in your
installation directory) and press OK.

8. Press OK on the ODBC Microsoft Access® Setup dialog. The
database is now ready for use. See below for a description of the
tables in the database.
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To Export Data to the Database
1. Select File| Connect to Database.

Note: Only one file can be connected to the database. If you
want to export data to the database _from another file, you
must disconnect the first file using File | Disconnect
Database. Then you can connect the second file to the
database.

2. There are two ways to export data.

The preferred way to export data is to export it while collecting
it. To do so, select Run | Auto Export to Database before you
collect data. Data is exported as it is collected. Do not continue
with step 3.

If you have already collected the data and want to export it to
the database, you must continue with step 3. Exporting data
from existing files consumes a lot of computer resources, and is
a slow process.

3. Select the sample or samples to be exported as follows:

To export data from a single sample, display the sample data in
the active graph or table window on the desktop.

To export data from multiple samples, select (highlight) the
samples you want to export from the Samples List window.

4. Select File | Export to Database. The data is exported to the
database.

Note: Be aware that exporting a group of samples to the
database takes considerable time. Do not exit the program
or close the file while it is writing to the database.
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Database Tables

The following information is collected in tables of the Microsoft”

Access® database.

T-00 Header

test num The test number. This number links the data in
the different tables. For auto export, it is
incremented for each “start data collection.”
When manually exporting data, each sample has
a different test number.

title As specified in the Properties dialog.

comment As specified in the Properties dialog.

test date Date of the FIRST sample for this test number.

filename Filename of the data file.

instrument id

Identifies the hardware the sample was collected
from. It is read from the instrument, or as
specified in the Properties dialog.

T-00 10 SMPS Settings

test num

The test number.

classifier model

As specified in the Properties dialog.

DMA model

As specified in the Properties dialog.

DMA inner radius

As specified in the Properties dialog.

DMA outer radius

As specified in the Properties dialog.

DMA characteristic As specified in the Properties dialog.
length
CPC model As specified in the Properties dialog.

gas temperature

As set in the Properties dialog.

gas pressure

As set in the Properties dialog.

gas viscosity

As set in the Properties dialog.

mean free path

As set in the Properties dialog.

channels per decade

As set in the Format menu.

multiple charge
correction

As set in the Properties dialog.

impactor type

As set in the Properties dialog.

up scan

As set in the Properties dialog.

retrace

As set in the Properties dialog.

down scan first

As set in the Properties dialog.

scans per sample

As set in the Properties dialog.

sheath flow

As set in the Properties dialog.

aerosol flow

As set in the Properties dialog.

CPC inlet flow

As set in the Properties dialog.

CPC sample flow

As set in the Properties dialog.

low voltage

Calculated from the Properties dialog.
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T-00 10 SMPS Settings

high voltage

Calculated from the Properties dialog.

minimum size

As set in the Properties dialog.

maximum size

As set in the Properties dialog.

density As set in the Properties dialog.

status The status of the instrument when the sample
was collected. Returned from the instrument.

td As set in the Properties dialog.

tf Calculated from the Properties dialog.

impactor D,

Calculated from the Properties dialog.

T-00 11 SMPS Data

test num

The test number.

sample num

The sample number.

channel num

The channel number

midpoint size

The midpoint size of the channel.

raw count

The raw count data.

dwdlogdp

The differential or normalized particle size.

T-00 12 SMPS Sample Data

test num

The test number.

sample num

The sample number.

sample date

The date the sample was collected.

Active Menus for an SMPS™ Spectrometer

This section describes the various functions available for an
SMPS™ through the menus on the Aerosol Instrument Manager®
desktop. The Menus include: File, Run, Playback, Format, View,
Sample, Window, and Help.

Which menus are available depends on the operation you are
currently performing on the desktop.

In addition to the menus, a toolbar (located just beneath the
desktop menus) is available to provide shortcuts to many of the
functions in the menus. You can hide the toolbar if you want to
enlarge the desktop, see the description of the View Menu, below.

Note: All menus and menu items are described below. Depending on
the operation you are currently performing and the window
that is active on the desktop, the menu may appear different
than shown, i.e., some menu items may not be available.
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File Menu

The items of the File menu are used to open, save, and recall files
and perform other program operations.

IHH Fun  Playback Format  Wiew  Sample Wi

Tl Chrl+h y
Qpern. .. Chrl+
Close

Save As...

Irnport
Export To File...

Connect ko Database

Properties, .. Ckrl+R
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Prinkt Setup...

1 CHDesh, it Tesk_11,580

2 CADeAAIM 8.2 D AimiATML . C87
3 C:\DeviAIM &.2,004im|AIM1E.550
4 C:\DeviAIM &.2,004im\AIM17.550

Exit

Figure 4-8
File Menu for an SMPS™ Spectrometer

New

Select File INew or 0] on the toolbar to open a new file and prepare
to collect sample data.

After you select New, you are prompted to enter a filename. Accept
the default filename or enter any filename you chose then
select OK.

A Samples List window and a graph window open on the desktop
with the filename you entered and you are ready to start collecting
data. Refer to “How to Collect Sample Data” for a complete
description.

Note: If this is the first time you have selected New, you may be
required to fill in the Properties dialog before continuing.
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Open

Select File |Open or [# on the toolbar to open an existing file. By
default, sample files are stored in the same directory as the Aerosol
Instrument Manager® program. All files will automatically be given
the appropriate filename extension according to the spectrometer
model you are using (see above description). If you store data files
in another directory or on another drive, you must first display the
file pathname in the Open window before you can select and open
it.
Note: When opening files for sample sessions that run past
midnight, refer to the description of Sequence Files in
Appendix E and for information on how the files are opened.

When the file opens, a window opens on the Aerosol Instrument
Manager® desktop containing data from the first sample in the file.

You can have many samples and many files open on the desktop at
the same time. Only one window, however, is the active window.

Close

Select File | Close or i to close a file (and all the windows
associated with it). If there are windows open on the desktop from
more than one file, Close will close only those windows associated
with the file whose window is currently active. If you attempt to
close a file that has been changed but not saved, you will be
prompted to save the changes before closing the file.

If you have marked a sample or samples for deletion, but have not
saved the file, you will get the following message: “Some samples
have been marked for deletion. Do you want them permanently
removed?” If you click Yes, the sample files marked for deletion are
permanently deleted. If you click No, the samples marked for
deletion are not deleted. They are saved, and are no longer marked
for deletion.

Save

Select File | Save or |E| on the toolbar to save sample data to a file.

If you have marked a sample or samples for deletion, but have not
saved the file, you will get the following message: “Some samples
have been marked for deletion. Do you want them permanently
removed?” If you click Yes, the sample files marked for deletion are
permanently deleted. If you click No, the samples marked for
deletion are not deleted. They are saved, and are no longer marked
for deletion.
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Save As

Select File | Save As to save data in an existing file to a new
filename. (The file contents are duplicated to the new filename. If
you want to delete the original filename, use Windows® Internet
Explorer® browser to do so.)

After you select Save As, you can select a drive/directory. You can
use the same filename if you save the file to another
drive/directory, but if you want to save the file to the same
directory, you must give it a new name.

Do not add the filename extension. It is added automatically when
you select Save.

Import

Select File | Import to import data into the program from previous
versions of the software. For example, to import a file from the
SMPS™ spectrometer, version 3.x or earlier, navigate to the
directory that contains the SMPS™ file and select the file you want
to import.

Export to File

Select File | Export to File to export data (either a single sample or
multiple samples of a file) for use in another program. Data is
exported in a delimited text file. Refer to “Export Data to a File” in
Chapter 3 for information.

Export to Database

Select File | Export to Database to automatically export data to a
Microsoft Access” database. Refer to information provided earlier in
this chapter.

Connect to Database

Select File | Connect to Database to connect the currently active
file to the database. Only one file at a time can be connected to the
database.

Disconnect Database

Select File | Disconnect Database to disconnect the file from the
database. You cannot disconnect from the database while data is
being written to the database. You are automatically disconnected
from the database when you close the file that is connected to the
database.
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Properties...

Select File | Properties to set the parameters used by the Aerosol
Instrument Manager® software to collect sample data. The
Properties dialog box has four tabs. The parameters that can be set
for each spectrometer on each tab are described in “How to Collect
Sample Data” earlier in this chapter.

Save Properties On Exit

Select File | Save Properties On Exit to save the settings in the
Properties dialog to the aim.ini file when you close a file. By default,
this setting is off. When it is selected (on), it is marked with a
checkmark and indicates that each time you close a file that file’s
properties are stored in the aim.ini file and are used as the
properties for the next New file.

Save Properties As Default

Select File | Save Properties as Default if you want the properties
currently displayed in the tabs of the Properties dialog to be the
default properties next time you open a New file.

Clear Settings

Select File | Clear Settings if you want to clear the Hardware
settings in the Properties dialog. If you clear the hardware settings,
you must fill in new hardware settings before you can begin
collecting data again. (Each time you select File INew, the
properties dialog box appears.) The settings are cleared from the
aim.ini file.

Print @I

Select File | Print to print the active window on the desktop in a
report format. If you want to preview the output before printing it,

select File | Print Preview or ] .

Refer to your Windows"® operating system documentation for
information about the Print dialog box.

Print Preview

To avoid printing something you don’t want, select File | Print
Preview to see what your printed output will look like before
selecting Print.
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Print Setup

Select File |Print Setup to set up the printer for printing. Refer to
your Windows® operating system documentation and your printer’s
documentation for information about setting the printer
parameters.

List of Recently Accessed Files

Between the Printer Setup and Exit menu items is a list of the most
recently accessed data files (a maximum of four files is displayed).
These are accessed from the menu by selecting Filel 1, 2, 3, or 4.

The list provides a shortcut to these files so you can bypass the
Open command. To open one of the files listed, use the mouse to
highlight it and then click the left mouse button. The file opens on
the desktop.

Exit
Select File | Exit to end the program.

Run Menu

The items available under the Run menu are used to start and stop
data collection.

N FPlayback Formakb  Miew Sample Wi

Connect to the CPC

Connect o Classifier 3080

Properties. .. Ckrl+R,

Figure 4-9
Run Menu for an SMPS™ Spectrometer

Start Data Collection

With a new file open on the desktop, select Run | Start Data
Collection or 3‘ on the toolbar to begin collecting sample data.
Samples are collected according to the sample length, number of
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samples, scheduled times and other parameters set in the tabs of
the Properties dialog (see earlier in this chapter).

Note: If a start time is set, this menu item (and its associated icon) is
disabled.

Once you select Start Data Collection, sampling begins
immediately. As data is collected, it is displayed in the open
windows.

Finish Current Sample

Select Run | Finish Current Sample when you want to stop
collecting sample data prematurely (before the sampling period
ends as set in the Properties dialog.). When you select this item, the
current sample is allowed to finish before sampling ends.

Abort Current Sample

Select Run | Abort Current Sample or B from the toolbar when
you want to stop collecting sample data immediately. When you
select this item, sampling stops and the data for the current sample
is discarded.

Connect to the CPC

Select Run | Connect to the CPC if you want to connect an open
data file to append more samples to the file. If a connection is not
found, the Properties dialog opens with the Communications tab
selected to let you establish a connection with the CPC.

Once there is a valid CPC connection, the New Sample icon appears
in the Samples List window and the Start Data Collection button
3‘ is enabled on the toolbar. You can then append samples to the
data file.

Disconnect from the CPC

Select Run IDisconnect from the CPC to disconnect an open file
from the CPC and stop collecting samples. You cannot append
samples to a file unless it is connected to the CPC. Once the CPC is
disconnected, the New Sample icon is removed from the Samples
List window and the Start Data Collection button 2‘ is disabled.

Connect to Classifier 3080

Select Run | Connect to Classifier 3080 to open a connection
between the software and the classifier.
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Disconnect from Classifier 3080

Select Run | Disconnect from Classifier 3080 to close the
connection between the software and the classifier.

Auto Export to File

Select Run | Auto Export to File to automatically export the data
as it is collected to a file. When you select this menu item, an
Export Dialog box opens. Select the type of data you want to
automatically export then press OK.

Note: You cannot auto-export raw data or export data in columns.

See “Export Data to a File.”

Auto Export to Database

Select Run | Auto Export to Database to automatically export the
data as it is collected to the Access database. See “To Export Data
to the Database,” earlier in this chapter for a description of how to
export SMPS™ data to the database.

Properties...
This menu item provides a shortcut to the same Properties menu

item listed under the File menu and appears here for convenience.

Select Run | Properties to display the Properties dialog that lets you
set the parameters used by the Aerosol Instrument Manager”
software to collect sample data.

The parameters that can be set are described earlier in this
chapter.

Playback Menu

The Playback menu appears only when a Sample List window is
active on the desktop. Its purpose is to allow you to display graphic
and table windows in series, like a slide show, so that you can
compare samples or view a series of samples.

Play

Figure 4-10
Playback Menu
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Refer to “Playback (Review) Data Samples” in Chapter 3 for
instructions.

Play

Select Playback | Play or L[ from the toolbar to display the control
window for playing the samples you selected. First select the time
you want each sample displayed (full speed, 0.5, 1.0. 2.5 or 5.0
seconds). Then select whether to view the samples once or
continuously. As soon as you select Play Once or Play
Continuously, the open views for the first sample you selected are
displayed for the specified period then the views for the second
sample are displayed, and so on until all the samples selected have
been displayed. If you selected Play Continuous from the Playback
Setup dialog box, the series repeats itself indefinitely.

Pause

Select Playback | Pause or m from the toolbar to interrupt the
playback of the samples. This feature lets you stop playback to view
the data of an interesting sample without canceling the playback of
all selected samples. When you want to start playback again, select
Playback | Play.

Stop

Select Playback | Stop or B from the toolbar to end sample
playback before all samples have been displayed. If you select Stop
and you want to restart sampling, you must select Playback | Play,
select the time you want each sample displayed, select play once or
continuously, and begin displaying samples from the first selected
sample.

Format Menu

The Format menu has many variations depending on the active
window. The menu items of the Format menu let you control how
information is presented in tables and graphs including: channel
resolution, view boundaries, graph type, grid lines, font, color, etc.
When a Sample List window is active on the desktop, the menu
items of the Format menu let you determine how items in the
Sample List window are displayed. You can select large or small
icons, or list the samples with or without details. Details include:
date, pathname, and title of the sample.

When a window is active on the desktop, you can display the

Format menu items (plus other menu items) by placing the cursor
in the window and clicking the right mouse button.

SMPS™ Spectrometer Procedures 4-29



4-30

Wiew  Sample Wi

¥ Axis, ..

Channel Besalution »
Wiew Boundaries, .,

Graph Tvpe »
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v Dekail
(A (B)
Figure 4-11

Format Menu for an SMPS™ File (A) When a Graph Window is Active (B) When a
Samples List Window is Active

Y Axis

This menu item is available only when a graph window is active on
the desktop.

Select Format | Y Axis to select the way the Y axis is displayed, see
Figure 4-12. By default, the graphs display in normal/auto scale.
You can select Auto or Fixed scale and either log or normal scale.
To display in logarithmic scale, check the Log Scale box.

If you select Fixed Scale, you must enter a minimum and/or
maximum number (you do not need to enter both).

(" Auto Scale [ Log Scale
® Fixed Scale
v
[ Minimum
| [ e |
Figure 4-12

The Y-Axis Dialog Box

Channel Resolution

Select Format | Channel Resolution to select the displayed
resolution of the measurement. The values 4, 8, 16, 32 and 64
channels/decade describe the resolution in terms of the number of
particle size channels of uniform geometric width per decade of
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particle size. A large number of particle counts during a sample
allows the use of high-resolution display (i.e., 64/decade). Low
count statistics make high resolution displays “noisy.” Lower
resolution displays average adjacent channels, reducing the
statistical variation. The actual resolution of the SMPS™
spectrometer is ultimately limited by the DMA, the sheath to
aerosol flow ratio, and particle diffusion.

View Boundaries

Select Format | View Boundaries to display the View Boundaries
dialog box, as shown below. Use the dropdown boxes to select the
upper and lower boundaries of the data’s size range that will be
viewed. Data is displayed between the selected boundaries and
statistics are computed based on the range of data between the
boundaries. Select Max View to include all data.

In the graph window, you can drag view boundaries by positioning
the cursor on the boundary you want to change, clicking the left
mouse button, and dragging the view boundary to the new location.
If the View Range = Valid Range box is checked, the boundaries
cannot be changed.

Yiew Boundaries g|

Lower pper

138 v|  ManView 7499 -

[ Miew Bange =% alid Bangs

] | Cancel |

Figure 4-13
View Boundaries Dialog Box

Graph Type
Select Format | Graph Type to select the type of graph to display in
the active window. The options are bar, line, or area. If the Graph
toolbar is visible, you can select the option using the appropriate
icon.

it Display graphs using bars.

L Display graphs using lines.

la Display graphs showing area.
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Grid Lines

Select Format | Grid Lines to select the lines for the graph in the
active window. The options are horizontal, vertical, both or none. If
the Graph toolbar is visible, you can select the option using the
appropriate icon.

]_I Display graphs with no grid.
El Display graphs with a horizontal grid.
MI Display graphs with a vertical grid.

ﬁl Display graphs with both horizontal and vertical grids.

Color &I

Select Format | Color to change the colors used to display items in
the active window.

When you select Format | Color, the Graph Color or Table Color
window opens depending on the active window on the desktop
(Figure 4-14 shows both). These windows include a preview screen,
a drop down list and a color palette. From the drop down list, select
the name of the item you want to modify. The current color for that
item is indicated in the color palette. Use the mouse to point to the
new color for that item and click the left mouse button to select it.
The preview screen then displays the item in the new color.
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Figure 4-14

(A) The Graph Color Dialog Box, (B) The Table Color Dialog Box

Select items from the drop down list and colors as desired. When
finished, press OK; the colors you selected will be used from that
point on in all graphs and/or tables.

The items you can select for windows containing graphs are:

Window Background
Plot Area Background
Labels

Axis

Data

Valid Boundaries

Impactor Cutoff Line

0O 0O 000 00D 0 O

Data Hotspot Lines
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The items you can select for windows containing tables are:
0 Window Background

Cell Text

Grid Color

Cell Background

0o 0 0 O

Fixed Area Text

Font él

Select the Format | Font menu to change the style and size of the
text in all graphs or tables.

Select Format | Font | Style... to select a new font or change the font
style, see Figure 4-15. You can select any font and font style
available on your computer. The preview box lets you see what the
text will look like before you implement it by selecting OK.

Font &‘

FEont: Font Style:

’E |Regular

Cancel

O Arial Black

T Arial monospaced for SAl
O Arial Narrow Bold Italic
T BankGothic Lt BT Y

Sample

AaBbYyZz

Figure 4-15
The Font Dialog Box

To change the font size, select Format | Font|Small, Medium, or
Large (the default is Medium). To change the text size without
using the menus, select the El icon from the toolbar. Each time
you select the icon the text size changes to the next text size.
(Rotation is from small to medium to large.)

Undo Zoom

Select Format |Undo Zoom to return a graph to its “normal”
viewing size after you have zoomed in on a portion of the graph. See
“Zoom In and Out on Data in a Graph” in Chapter 3.
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View Menu

The list of items in the View menu depends on which windows are
open on the desktop and which one is active. The View menu lets
you select the sample windows to open on the desktop and select
parameters to view in those windows. A checkmark next to an item
indicates the item has already been selected. Look under the
Windows® menu to find the item and make it the active window.

Sample  Window  Help

Units b
eight *
Size Data b
Raw Data L4
Skakistics Fa
Settings F4
v Sample
Copy ChrliC
Toalbars r
Figure 4-16

View Menu for an SMPS™ Spectrometer

Units

The Units menu item appears when a size data graph, table, or
statistics window is active on the desktop. This menu item works in
conjunction with the Weight menu item, and lets you choose the
units in which data will be displayed.

Unit selections include:

Sample  windoms  Help

v dWidocop

Weight r Concentrakion (dWw)
% Concentration

size Data g Curnulakive Conc,

Faw Data g Cumnulakive % Caonc,

Skakistics F3 Raw Counts
Figure 4-17

Units Selection Menu

The currently selected unit is marked with a check mark. This was
set by selecting View | Units | dW/dlogDp.
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Table 4-5 gives an explanation of each unit.

Table 4-5

Display Options for Units

View Units Description

dW/dlogDp This option displays differential or normalized

particle size distribution, normalized to one
decade of particle size. This normalized
concentration format allows particle size
distributions to be compared regardless of the
channel resolution. dW/dlogDp = dW x resolution
in channels/decade. W represents the weighting of
the distribution, which can be N (number), S
(surface area), V (volume), or M (mass).

Concentration (dW)

This option displays interval particle size
distributions. The concentration in any channel
represents the concentration within the particle
size boundaries for that channel. W represents the
weighting of the distribution, which can be N
(number), S (surface area), V (volume), or M
(mass).

% Concentration

This option displays each particle size channel as
a percentage of the total particle concentration.

Cumulative Conc.

This option displays the particle concentration in a
cumulative or summed format. Each particle size
channel represents the total concentration of
particles measured below its upper size boundary.

Cumulative % Conc.

This option is the same as Cumulative Conc., but
displayed as a percentage of the total
concentration.

Raw Counts

Raw Counts are the lowest level of data
representation, raw detected particle counts put
into channels by size, but without any corrections.
Mapping of particle size within the program can
cause single counts to be split across two
channels.

Figure 4-18 shows a data graph from an SMPS™ spectrometer.
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Electrical Mobility Diameter Data Displayed in %Concentration
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Weight

The Weight menu item appears only when a graph window is active
on the desktop. This menu item works in conjunction with the
Units menu item and lets you choose how to “weight” the units that
are displayed.

You can select:

Sample  Window  Help

Unit=s o
v Mumnber
) Diameter
| Size Data ¥ Surface
Faw Data ¥ Volume
Skatistics F3 Mass
Figure 4-19
Weight Menu

The currently selected weight is marked with a check mark.
Table 4-6 gives an explanation of each unit.
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Table 4-6
Weight Options

View Units

Description

Number

Number represents the total number of particles per unit
volume of air sampled (i.e., number concentration
expressed as #/cm’). Number concentration is the
primary measurement of the SMPS™ system. The
spectrometer is sensitive to the number of particles in
the aerosol sample as opposed to the particle mass,
color, shape, composition or other characteristic. The
distributions of diameter, surface area, volume or mass
concentrations of the particles are calculated based on
the particle number distribution.

The number concentration, dN, measured by the
SMPS™ spectrometer is the concentration of particles in
a given channel. The normalized number concentration,
dN/dlogDp, is calculated by dividing dN by the geometric
width of the size channel.

Diameter

Diameter represents the first moment of the diameter, or
the total of all particle diameters per unit volume of air
sampled, in units of mm/cm®.
Diameter moment is calculated by:

dD=dN - D,
where D, is the geometric midpoint of the particle size
channel. The normalized diameter concentration is:

dD/dlogD, = dN/dlogD, - D,.

Surface

Surface represents the total surface area of the particles
per unit volume of air sampled (i.e., surface area
concentration expressed as nm’/cm?. The surface area
concentration calculation assumes that all the particles
are perfect spheres.

Surface area concentration is calculated by:
dS=dN: = Dpz,
where D is the geometric midpoint of the particle size

channel.
The normalized surface concentration is:

ds/dlog D,=dN/dlog D, - 7D .

P

Volume

Volume represents the total volume of the particles per
unit volume of air sampled (i.e., volume concentration
expressed as nm°’/cm?®). The volume concentration
calculation assumes that all the particles are perfect
spheres.
Volume concentration is calculated by:

dV =dN - (n/6)D’,
where D, is the geometric midpoint of the particle size
channel.
The normalized volume concentration is:

dV/dlogDp = dN/dlogDp - (n/6)D°.
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View Units Description

Mass Mass represents the total mass of the particles per unit
volume of air sampled (i.e., mass concentration
expressed as pg/cm’). The mass concentration
calculation assumes that all the particles are perfect
spheres with the density defined in the Run/Properties
dialog for the instrument.
Mass concentration is calculated by:

dM = dN - (x/6)D,’p,
where D, is the geometric midpoint of the particle size
channel and p is the density. This quantity is related to
Volume concentration by the simple factor p. The
normalized mass concentration is:

dM/dlogDp = dN/dlogDp - (n/6)D °p.

In many of the tables, the values for all four weightings are
supplied in tabular format.

Note: Surface, Mass and Volume weighting calculations assume that
all the particles are spherical. Mass calculations also assume
that all particles have the density defined in the properties
dialog for the instrument. However, comparisons to methods
that measure particle surface, volume or mass directly may
give results different from those calculated by the software.

Figure 4-20 shows size data in units of cumulative % concentration
weighted by mass.
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Figure 4-20
Size Data Weighted by Mass

Size Data

Select View | Size Data to open a graph or a table window that
displays the file’s sample data based on size.
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Raw Data

Select View |Raw Data to open a graph or a table window that
displays the raw data of the active sample.

Molecular Mass (macrolMS™ spectrometer only)

Select View/Molecular Mass to open a graph of sample data
plotted versus molecular mass in kilodaltons.

Note: The Molecular Mass axis is intended for displaying results of
macromolecule measurements made using macrolMS™
spectrometer, or Macroion Mobility Spectrometer. The
macroIMS™ spectrometer combines the Model 3936N76 or
3936N86 SMPS™ spectrometer with the Model 3480C Charge-
reduced Electrospray Ionization (ESI) Source to generate, size
and quantify singly-charged individual macromolecules from
liquid samples. The Molecular Mass axis is calculated
assuming all particles are spherical with the density defined in
the Properties dialog for the instrument. The Dalton is a unit
equal to one atomic mass unit (amu), or 1.66057 x 10"-27 kg
(carbon-12 scale).

Statistics

Select View | Statistics to open a window of statistical information
for the active sample, see Figure 4-21. The equations used for
calculating the values are described in Appendix C.

Statistics Table [Outdoor Air.S80]

Number Diameter Surface Volume Mass
Particle Size | Particle Size | Particle Size Particle Size Particle Size
Median (nm) 494 | 843 | 1634 825 Fr 0
Mean (nm) B5.9 117.1 2025 2.0 302.0
Geo. Mean (nm) 50.8 a7.1 156.8 2545 254 5
Mode (nm) | 59.4 B5.1 2595 346.0 346.0
Geo, St. Dev. 2.00 2.15 21 1.88 1.68
Total Conc. | 6.06e+04(#cm?) | 3.99(mmicm?) | 1.47e+09(nm%cm?) | 4.96e+10(nm%em?) | 59 5(pg/m?)
Sample #7 Ok
Figure 4-21
Statistics Table
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Settings

Select View | Settings to display the Properties settings for the
SMPS™ spectrometer sample that is active on the desktop, as
shown in Figure 4-22.

SMPS Settings [Sodium Chloride_low flov. SEO]

BX

Title:
Classifier Model: 3080 DMA Model: 3081
Impactor [cm]: Mone CPC Model: 3776 Low Flow
DMA Sheath Flow [lpm]: 2.0 Instrument 1D: 3776 70000000 089,
DMA Aerosol Flow [ipm]: 0.3 Lowaer Size [nm]: 149
CPC Inlet Flow [lpm]: 0.3 Upper Size [nm]: £73.2
Low Voltage [V]: 11 Particle Density [g/cc]: 1.2000
High Voltage [V]: 9559 Multiple Charge Correction: OFF
Gas Viscosity [kg/(m™s)]: 18203005 td [s]: 343
Mean Free Path [m]: E.6500e-008 o [s]: 7.5
Down Scan First: FALSE Impactor D50 [nm]: 1000
Scan Up Time [s]: 120 DMA Inner Radius [em]: 0.937
Retrace Time [s]: 15 DMA Outer Radius [cm]: 1.961
Number of Samples: 1 DMA Characteristic Length [em]: 44369 a4
Scans Per Sample: 1
lggumum | |
Sample #1 oB
Figure 4-22

Select Settings to Display SMPS™ Settings for the Sample

Sample

Select View | Sample to view the current sample selected in the
Samples List window.

Reference

Select View | Reference to view the reference buffer selected with
Sample | Select as Reference.

Sample—Reference

Select View | Sample-Reference to view the current sample minus
(-) the reference sample. This menu item is not available if no
sample has been selected as a reference using Sample | Select as
Reference.

Sample-Reference is only allowed for the following units:
Concentration (dW), dW/dlogDp, and Cumulative Conc.

SMPS™ Spectrometer Procedures
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Sample/Reference

Select View | Sample/Reference to view the current sample divided
by (/) the reference sample. This menu item is not available if no
sample has been selected as a reference using Sample | Select as
Reference.

Sample/Reference is only allowed for the following units:
Concentration (dW), dW/dlogDp, and Cumulative Conc.

Note: Statistics are not calculated for this option. All fields in the
table will be blanlk.

Copy

Select View | Copy or from the toolbar to copy the active
window so that you can “paste” it in other applications, for example
a word processing program.

Toolbars

Select View | Toolbars to display or hide the toolbars that appear on
the desktop. Each toolbar is illustrated below:

‘D EEH kRS L =

‘ Main Toolbar

@ A X
Color and Font Toolbar
|I:|g UMD
‘ |M|El‘”t§ﬂ”lﬁ| e Graph Toolbar

ﬁlﬂ !l M QI ilﬁl il Navigation Toolbar

The Data Merge icon ha appears on the main toolbar if the
appropriate software has been installed. See Chapter 2, “Installing
the Software” for more information.

By default, only the Main and Navigation toolbars are displayed.

To view what each icon (tool) does, position the cursor on the icon.
A balloon appears describing the function of the icon.

Toolbars can be moved and resized if desired. To move a toolbar,
position the cursor on a gap between two tools and press and hold
the left mouse button. As you move the mouse, the toolbar moves
with it. To resize a toolbar, position the cursor at an edge or corner
of the toolbar window that you have moved and resize it as desired.
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You can hide a toolbar by selecting the “x” in the upper right
corner.

Sample Menu

The Sample menu lets you navigate through files with multiple
samples and select and clear a reference sample.

Note: You can also navigate through files with multiple samples
using the Navigation toolbar.

Window  Help
Mext Sample Al
Ending Sample Alk+E

DeleteUndelete Sample Del

Select As Reference

Select All kA,
Figure 4-23
Sample Menu
Beginning Sample

Select Sample | Beginning Sample or ﬁl from the toolbar to
display the data for the first sample of the file in the active window.

Previous Sample

Select Sample | Previous Sample or |ﬁ| from the toolbar to display
the data for the previous sample of the file in the active window.
Next Sample

Select Sample | Next Sample or ﬁ[ from the toolbar to display the
data for the next sample of the file in the active window.

Ending Sample

Select Sample | Ending Sample or |ﬂ| from the toolbar to display
the data for the last sample of the file in the active window.
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Delete/Undelete Sample

Select Sample | Delete /Undelete Sample to mark a sample for
deletion or to unmark a sample that has been previously marked
for deletion. Sample data that is marked as deleted are not
physically deleted from the file until you select File | Save or
File|Close.

Select As Reference

Select Sample | Select As Reference to select the current sample
as a reference sample. This sample can then be subtracted from the
current sample or you can divide the current sample by the
reference sample. Refer to the View menu items above.

Clear Reference Buffer

Select Sample | Clear Reference Buffer to clear the reference
bulffer.

Select All

Select Sample | Select All to select (highlight) all samples in the
Samples List window for playback or exporting. This item is only
available when the Samples List window is the active window.

Window Menu

The Window menu items let you open, close and arrange the
windows on your desktop. Refer to your Windows® operating system
documentation for an example of what each command does.

s ol Help
! 2-Pane Layouk Chr+HE
1 4-Pane Layouk Zhrl+L
Cascade

Tile Horizonkal
Tile Yertical

Close all

1 Skatiskics Table [Cukdoor Air,550]
2 Size Data Table [Outdoor &ir,550]
3 Size Data Graph [Oukdoor &ir, 5507
4 9MPS Setkings [Oukdoor Air, 5507
v 5 SMPS - Samples Lisk [Oukdoor gir,5380]

Figure 4-24
Window Menu

Aerosol Instrument Manager® Software for SMPS™ Spectrometer



All windows on the desktop, whether active or inactive, are listed
after the Close All command; the active window is shown with a
check mark. To make a different window active and bring it to the
front, select it with the mouse.

Help Menu
The Help menu provides access to information about the program.

about Aerosol Instrument Manager. ..
Help Manual F1

Figure 4-25
Help Menu

About Aerosol Instrument Manager

Select About Aerosol Instrument Manager to see the copyright
statement for the program and view the version number of the
software.

Help Manual

Select Help | Help Manual to see the manual of the Aerosol
Instrument Manager® software for SMPS™ spectrometer.
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Status Bar Icons

A status bar at the bottom of most windows provides information
about what is being shown in the window as well as information
about what operations are occurring.

Each icon is described below:

Icon Description

E Attention. The scan returned with one or more status flags
set. Move the mouse over the icon to view the tool tip which
displays the status text.

Charge correction is off.

Charge correction is on.

Diffusion correction is on.

Nanoparticle aggregate mobility analysis is on.

Down scan in progress.

Up scan in progress.

o= = ]| BB

Scan completed without problems.

The software displays particle density on the status bar below the
size graph. If the software is connected to the Model 3080
Electrostatic Classifier, it also displays sheath temperature and
absolute pressure read from the instrument.

Diameter (nm)
11 of 45 sec |[Sample Run 1f1 Sample #1 | 2534 %C 97,1 kPa ‘I‘ Density (gfcc): 1,20

Figure 4-26
Status Bar Displaying Particle Density

If the software is not connected to the Model 3080 Electrostatic
Classifier, the temperature and pressure at the bottom of the graph
will be displayed as dashed lines.

Diameter (nm)

Mew Sample | --*C  --kPa

Density (gfcc): 1,20

Figure 4-27
Status Bar Displaying Dashed Lines
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APPENDIX A

Data Files, Project
Files, and Stored
Parameters

The Aerosol Instrument Manager® software stores data in two types
of files: data files and project files. This appendix describes those
files and the parameters stored in them. In addition, it also
describes the parameters stored in the aim.ini file.

Data Files and Project Files

The Aerosol Instrument Manager® software uses two types of files:
U Data files
U Project files

Data files contain sample data. They have a filename extension to
indicate the type of spectrometer from which data was collected,
such as .s80 for an SMPS™ spectrometer. Other information stored
in data files includes:

Information stored for the whole file:
Q Classifier model

DMA model number and dimensions

CPC model

CPC 3022A high flow inlet flow rate

Reference gas viscosity, temperature and pressure
Reference mean free path

Time file started

0O0000DO

Information stored for each sample:

U Sheath temperature and absolute pressure from Model 3080
Classifier (if available)

U Mean free path and gas viscosity calculated from sheath
temperature and absolute pressure (if available)

O Impactor type

A-1



Aerosol and sheath flow rate
Size range

Voltage range

Up scan and retrace time

Down scan first (for 3071)
Density

td, tf, D50 of Impactor

Scans per sample

Time sample started

Status flags from the instrument

Instrument ID

o000 o0o0o0o0o0o0 oo

Title and comment text

Project files are created by the program when you open a data file
and work with it. They have an extension to indicate the type of
spectrometer that they are the project files for (for example, .p80 for
an SMPS™ spectrometer). Project files keep track of “cosmetic”
attributes like which windows are open on the desktop when you
close the file and how that information is displayed.

If you transfer data files to someone, you do not need to transfer
the project files unless you want to. If you delete a project file, a
new project file is created when you reopen the data file.

Project File Parameters

A-2

The following parameters are saved for each window (i.e., the Units
for the Size Data table are stored for the Size Data table only, the
Units for the graph are stored only for the graph):

U The graph type (bar, line, or area)

U The grid type (none, vertical, horizontal or both vertical and
horizontal)

Y axis scale parameters
Units and weights selected

List type, for the Samples List window

000 o

Position and size of the window

Aerosol Instrument Manager® Software for SMPS™ Spectrometer



The following parameters apply to the entire file (not to each
individual window):

a

Q
a
a

O

Multiple charge correction
View range
Channel resolution

Reference sample number and the way data is viewed compared
to the reference buffer

Playback delay time

Current sample index (the sample number of the sample you
were viewing when you exited the program)

Saved Parameters

The following parameters are stored for the Aerosol Instrument
Manager® application and are applied to all documents:

Q

Q

Q

Font and color for tables.
Font and color for graphs.

Aerosol Instrument Manager® window size and position.

The following two items are also stored according to the instrument
type selected.

Q

Q

Window positions the last time a file was closed.

Parameters from each different instrument Properties dialog
box.

Data Files, Project Files, and Stored Parameters A-3
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APPENDIX B
Accelerator Keys

Accelerator keys are those keys and key combinations that allow you to

perform operations using only your keyboard (no mouse required).

These are the accelerator keys that can be used with your

spectrometer.
Key(s) Action for SMPS™ Spectrometer
F1 Help
F3 View statistics
F4 View settings
F5 View size data
Shift F5 View size data table
F6 View size data raw graph
Shift F6 View size data raw table
F10 Start sampling
Shift F10 Finish recording current sample
Alt B Go to first sample “Begin”
Ctrl A Select all in the Samples List window
Ctrl C Copy current view to clipboard
AltE Go to last sample “End”
Ctrl K Arrange windows in 2-pane layout.
Ctrl L Arrange windows in 4-pane layout
Alt N Next sample
Ctrl N New document
Ctrl O Open a document
Alt P Previous sample
Ctrl P Print current view
Ctrl R Display sample properties
Ctrl S Save
Z Undo Zoom in graph

B-1
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APPENDIX C
Calculations Used for

SMPS™ Spectrometer

This appendix gives an explanation of the statistics calculations
used by the Aerosol Instrument Manager® Software. The statistics
are calculated for the interval defined by the upper and lower
bounds selected from the graphs, which are not necessarily the
entire size range of the instruments.

Statistic/Weight Number Surface Area | Volume Mass
Concentration I [ s = 7Z'D§Tl D 2 n m = pv
t n v = 6
Total U U U U
Concentration N = ZI: n S = Z S V= Zv M = Z m
l
Mode D, (Nyax) D, (Smax) D, (U max) D, (M)
Median (X ) D,(N/2) D,(S/2 D,V /2 D,(M /2
Mean (X)) u u u u
Z nD p Z sD b ZUD P Z mD p
l L l l
N S \% M
Geometric Mean [ u substitute s, v, mand S, V, M
(X,) z ninD, in place of n and N for other
1 C
exp| —— weightings
p N g g
Geometric M u % substitute s, v, mand S, V, M
Standard Z n[ln D,-Inx, ]2 in place of n and N for other
Deviation (o g ) exp L weightings
N
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The symbols used in the formulas are defined as:

¢ = particle counts per channel

n = number weighted concentration per channel

s = surface area weighted concentration per channel
v = volume weighted concentration per channel

m = mass weighted concentration per channel

n = sample efficiency factor per channel

¢ = sample dilution factor

D, = particle diameter (channel midpoint)

C = total particle counts

N = total number concentration

S = total surface area concentration
V = total volume concentration

M = total mass concentration

@ = sample flow rate

t = sample time

p= particle density

In = natural log

exp = base of natural log (e)
l = lower channel boundary
u = upper channel boundary
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APPENDIX D

SMPS™ Software
Comparison

The calculations performed by the Aerosol Instrument Manager”
software version of the Scanning Mobility Particle Sizer™ (SMPS™)
software are essentially the same as those used in the original
versions of the Windows® operating system SMPS™ software. Some
small changes were made that will slightly affect the measurement
results as compared to the original Microsoft® Windows® operating
system SMPS™ software. These are:

O Cunningham Slip Correction. The calculation of the slip
correction is given by:

21 —0.999Dp
CC =1+D—(1142+558€ 24 )

p

This calculation is used uniformly throughout the SMPS™
program. In the Windows® operating system version of the
SMPS™ software, two different equations were used. One is
used in calculating the particle charge probability table and the
other is used in the calculation of particle size.

0O Boundary Calculations. The original Windows® operating
system SMPS™ software was not consistent in its use of particle
diameter boundaries versus diameter midpoints when
calculating the starting and stopping voltages for the
measurement scan. This small inconsistency has been
corrected in the Aerosol Instrument Manager® software and the
measurement scan now correctly starts at the lower boundary
of the first channel to be measured and ends at the upper
boundary of the last (largest) diameter channel. Both programs
calculate the measurement scan range based on channels
binned to 64 channels per decade of particle size.

O Constants. The value for mean free path was changed from
6.53e-8 m to 6.65e-8 m. The value for gas viscosity was
changed from 1.834e-5 to 1.8203e-5. Both of these parameters
can be adjusted in the properties dialog of the Aerosol
Instrument Manager® SMPS™ software.
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0 Round-off Error on Starting Voltage. It was discovered that
the starting and stopping voltage scanning parameters delivered
to the CPC were truncated rather than properly rounded-off to
the appropriate value. This has little effect on the stopping
voltage value, which is typically large compared to the
truncation error. However, at the stating voltage, which can be
as low as 10 volts, the truncation error is significant. While the
new SMPS™ software now properly rounds the result, the CPC
continues to take only integer values of voltage as parameters
so some error still exists. When possible, the user should use
higher flow rates and a smaller DMA (such as the Model 3085
Nano DMA) to raise the starting voltage for smaller particles,
thus reducing any errors from the round-off.

Aerosol Instrument Manager® Software for SMPS™ Spectrometer



APPENDIX E
Sequence Files

The files for sample sessions that run past midnight (or run for
more than 24 hours) are handled differently than those that start
and stop on the same date. (Midnight occurs on your system
according to the setting of your computer’s system clock.)

For these sample sessions, a sequence of files is created, with
each file in the sequence given a unique filename extension
identifying its proper order.

Normally, only a single file is created for any sample session and it
has a filename extension of the form .s80. For example,
Atomosphere.s80, which would identify the file as an SMPS™ file.

If the sample session period runs past midnight, a file is created for
each date (day). The samples collected before midnight (including
the sample that is running at midnight) are collected in a file with
the normal extension, i.e., .s80

Samples that are collected after midnight are saved in a file with an
extension of the form “.1.s80”. (Using the same example as above,
the next filename would be “Atmosphere.1.s80.”)

For a very long sample session, a file is created each time the
sample session runs past midnight and is indicated by adding a
new number to the file extension. Using the previous example, the
file following “Atmosphere.1.s80” is “Atmosphere.2.s80” and the
next file would be “Atmosphere.3.S80” and so on.

These files contain information to link them when opened and the
files can be recalled as if they were a single file. The files may also
be selected and opened as individual files.

When you save the samples collected during a sample session that
runs past midnight, you provide a filename just as you would for
any sample session. You do not provide any extensions. The
software automatically adds a file extension.
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Opening a File That is Part of a Sequence

If you select File | Open and the file is part of a sequence of files
(i.e., the sample session ran over midnight), the following dialog box
appears:

File Question?

\_‘-fj The file you have selected is part of a sequence of files. Do you want to view all the files?

— Ies — o

Figure E-1
File Question? Dialog Box

You have the option of opening all the files or only a single one.

If you select No, only the file you have selected will open and only
the samples in that file will be available to you.

If you select Yes, all files in the sequence will open and the samples
from the entire session are available as if you had opened a single
file.

Note: If you select View | Samples List | Details, you can see the
pathname for each sample.

When you open a sequence of files, the software looks for the first
file of that sequence (i.e., the one with the .s80 extension and opens
all files in sequence beginning with that file). If a sequence file is
unavailable (for example, it has been deleted, moved or corrupted),
the software opens the files until it comes to the missing file. For
example, if you try to open a sequence of files that contains seven
files and the fourth file is missing, only the first three files can be
opened. Files five, six, and seven are “orphaned.” These remaining
files (5, 6, and 7) can only be opened individually, not as a
sequence.
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APPENDIX F
Error Messages

This appendix lists the messages you may encounter when using
the software and suggests the action you should take.

Table F-1
Error Messages for SMPS™ Spectrometer

Error Message

Description

<file> already exists. Do you want to append
to it?

The text file selected already exists. New exported data will be
appended to the end of the file.

0 is invalid when using a log y scale

You must enter a number greater than zero to proceed.

0 is not valid for the maximum value

You must enter a number greater than zero to proceed.

Aerosol Flow Rate must be >= 0.1

Error in the Properties | Hardware Settings page.

All of the necessary settings have not been
selected. (You cannot exit the hardware
settings page until all of the fields are set.)

Error in the Properties | Hardware Settings page.

Cannot calculate a valid size range with the
current Gas Viscosity and/or Mean Free Path
values.

Incorrect values were entered in the Properties| Physical
Properties page.

Cannot close the Aerosol Instrument Manager
database.

Cannot communicate with the instrument.
Please check that it is connected, turned on,
has the correct comm settings set in the
properties, and that the port is not in use by
another application

Communications error, the software cannot communicate with
the hardware. Please check the items indicated in the
message.

Cannot find a file (<filename>) in the sequence
of files associated with <filename>. Only the
samples loaded will be available.

Warning to let you know that the sequence of files has a gap
and the program cannot load all of the files.

Cannot open the Aerosol Instrument Manager
database.

Verify that the database file is not corrupted.

Cannot write to the Aerosol Instrument
Manager database. Database connection will
be closed.

Data Error. An incorrect amount of data was
received in the current run. Sampling was
stopped and excess data, if any, was ignored.

For information only.

Fixed Scale is selected. You must select a
Minimum and/or Maximum value.

If you want to use the fixed scale parameter, you must select a
minimum or maximum value.

Gas Viscosity cannot be zero

Incorrect values were entered in the Properties| Physical
Properties page.

Gas Viscosity must be < 1.0. Make sure the
units are correct

Incorrect values were entered in the Properties | Physical
Properties page.




Error Message

Description

Log y scale is invalid because the minimum y
scale value is set to O

You have tried to select log Y scale and you also have O as the
fixed minimum value. You cannot have both selected. Change
one.

Maximum value must be > minimum value.

You have entered a minimum value that is greater than the
maximum value. Reenter the correct values.

Mean Free Path cannot be zero

Incorrect values were entered in the Properties| Physical
Properties page.

Mean Free Path must be < 1.0. Make sure the
units are correct

Incorrect values were entered in the Properties| Physical
Properties page.

Retrace time must be >= 10

Error in the Properties | Hardware Settings page.

Sample #x will be discarded and cannot be
recovered. Do you want to discard it?

Answer yes if you want to permanently remove the sample
from the file.

The CPC efficiency file is missing. All 1's will
be used for data correction.

The efficiency file is needed to correctly convert the raw data to
raw counts. The file needs to be in the same directory as the
aim.exe file.

The CPC is reporting a fault. Do you want to
start sampling anyway?

Select OK to continue.

The CPC Model 3022A Inlet Flow Rate applies
to all samples in the data file. Are you sure
you want to change the Inlet Flow Rate

Incorrect values were entered in the Properties| Physical
Properties page.

The CPC Model applies to all samples in the
data file. Are you sure you want to change the
CPC Model?

Incorrect values were entered in the Properties| Physical
Properties page.

The current td value was set by the user, do
you want to recalculate using new
parameters?

Incorrect values were entered in the Properties | Physical
Properties page.

The user efficiency file is missing. All 1's will
be used for data correction.

The efficiency file is needed to correctly convert the raw data to
raw counts. The file needs to be in the same directory as the
aim.exe file.

The file selected is not a valid SMPS™ data
file.

The imported data file must be from version 3.1 or earlier of
the TSI SMPS™ software.

The file you have selected is part of a sequence
of files. Do you want to view all the files?

You have selected a file that is part of a sequence of files. You
can select Yes to view all the files or No to view only the file
you initially selected.

The size range is invalid for the selected Gas
Viscosity and/or Mean Free Path values. Do
you want to recompute the size range based
on the new values?

Incorrect values were entered in the Properties| Physical
Properties page.

The starting hour is invalid

Properties | Scheduling values are invalid.

The upper size must be greater than the lower
size

Reenter the values.

The User Defined intersample time is less
than the sample length

Properties | Scheduling values are invalid.

The voltage range is invalid. Do "Set to Max
Range”

The voltage range is 10 — 10,000 for the 3080 classifier and 10
— 11000 for the 3071 classifier.

This sample is the Reference sample. Do you
want to discard the sample?

Select OK to discard the sample.

Unable to create the graph control.

The graph control OCX is not registered properly on your
system. Contact TSI for support.
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Error Message

Description

Up Scan time must be at least 2*Retrace time

Error in the Properties | Hardware Settings page.

Upper channel boundary must be larger than
lower channel boundary.

You have selected a channel boundary for the upper channel
that is lower than the channel boundary for the lower channel.
You must select a channel boundary that is higher than the
lower channel.

You cannot close while writing to the
database.

Wait until the data is written to the database and then close
the file.

You must enter a maximum value

You must enter a maximum value to proceed.

You must enter a minimum value

You must enter a minimum value to proceed.

Error Messages F-3
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APPENDIX G

Scanning Mobility
Particle Sizer™ (SMPS™)
Spectrometer Diffusion
Loss Correction

Why Are Diffusion Losses Important in the
SMPS™ Spectrometer?

To understand why we need a Diffusion Loss Correction, it is
necessary to recall three facts:

1) When aerosol particles collide with a surface they adhere due to
van der Waals force, electrostatic force and surface tension.

2) Diffusion is the primary transport mechanism for particles
smaller than 0.1 pm (100 nm).

3) The smaller the particle the more rapid the diffusion.

Thus, if an aerosol particle diffuses to the wall of its measurement
flow path, there will be diffusion losses, and the measured size
distribution will under represent small particles. Since the
Scanning Mobility Particle Sizer™ (SMPS™) spectrometer measures
particles in the size range of 2.5 nm-1000 nm, diffusion losses are
unavoidable. They are however, quantifiable.

Diffusion losses are frequently characterized in terms of penetration
Nout

Nin

(P) through a tube: P =

Penetration is a function of the particle diffusion coefficient (D),
length of the tube (L), and volumetric flow rate (Q). The Diffusion
coefficient (D) is affected by temperature, gas medium, and particle
diameter.
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Circular Tube Penetration Efficiency
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Figure G-1
Circular Tube Penetration Efficiency [Gormley and Kennedy (1949)]

Note that the diffusion loss through a tube (for a fixed volumetric
flow rate) is not a function of tubing diameter. The additional
distance the particles must travel to the walls in a wider tube is
offset by a longer residence time.

How Can You Characterize Diffusion
Losses in the SMPS™ Spectrometer?

G-2

The Scanning Mobility Particle Sizing™ (SMPS™) spectrometer can
be broken down into five different flow paths for which an aerosol
penetration can be calculated.

P, = Penetration through the impactor inlet

P, = Penetration through the bi-polar neutralizer and internal
plumbing

P, = Penetration through the tubing to the Differential Mobility
Analyzer (DMA) and CPC

P, = Penetration through the DMA
P, = Penetration through the CPC

Aerosol Instrument Manager® Software for SMPS™ Spectrometer



Figure G-2
Schematic of the Component Scanning Mobility Particle Sizer™ Spectrometer

The total penetration through the system is the product of the
individual penetration values:

Prowat = P1P2P3P4Ps

Determination of P,

The penetration through the impactor assembly was determined
experimentally using all three impactor sizes (0.0457 cm,

0.0508 cm, & 0.071 cm) and a variety of flow rates. P, is dependent
on the Reynolds number so it is affected by the flow rate and the
gas properties of the working gas. When using an impactor, it is
important to stay within the recommended flow ranges to achieve
the highest accuracy for the Diffusion Loss Correction.

Determination of P,

The penetration through the internal passages of the Model 3080
Classifier (including the Model 3077/3077A neutralizer) was
determined experimentally at a variety flow rates. P, is a function of
the particle diffusion coefficient and flow rate.

Scanning Mobility Particle Sizer™ Spectrometer Diffusion Loss Correction G-3



Determination of Pj

Penetration through the connecting tubing was calculated using
Gormley and Kennedy’s equations for penetration through a
circular tube'.

Note: Diffusion Loss Correction was designed for use with CPCs in
“high flow mode” where this option is available.

Determination of Py

Penetration through each of the Differential Mobility Analyzers
(Model 3085 and Model 3081) was determined using published
data®** on the transfer functions for these DMAs and was also
validated experimentally.

Determination of Pg

P.is the counting efficiency of the CPC and includes penetration
inside the CPC, activation efficiency and optical detection efficiency.

Note: All of the experiments were performed using air at Standard
Temperature & Pressure (STP) as the working gas. Since
diffusion losses are a_function of the particle diffusion
coefficient (D) and D is a_function of the working gas
properties, the use of different working gases and/or
conditions will result in an error in the calculated diffusion
loss. It is possible to input gas properties in the software to
increase the Diffusion Loss Correction accuracy, but other
working gases and conditions have not been experimentally
verified.

How Does It Work?

Simply open the SMPS™ Properties box in the Aerosol Instrument
Manager® Software and under Correction Flags and Values check
the Diffusion Correction box and enter the carrier gas density (the
default value is the density of air).

Note: The correction can be toggled on and off and can be applied to
previously collected data similar to Charge Correction.
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SMPS Properties - New Sample

Hardware Settingsl Scheduling  Physical Properties l

Reference Gas Properties

Gas Viscosity [ka/ms)) |1.83245e-005 Set to Defaults for Air ‘

Mean Free Path [m] B.73e-008 Sutherand Constant (k] [170.4
Temperature (K] 23815 Pressure [kPa] 10.3

Farticle Density [g/cc)  |1.2000

Correction Flags and alues

[ Multiple Charge Comrection
[ Diffuzion Correction ’7

[ Manoparticle Aggregate Mobiliby Analysis

Title |.~’-‘n.ir ten feet wertical from exhauszt

Instrument [D |SMF'S

Commett 3:00 am

ar. | Cancel

Figure G-3
SMPS™ Properties Box Screen of Aerosol Instrument Manager® Software for the

SMPS™ Spectrometer

Note: Diffusion Loss Correction was designed and validated for use
with the Model 3080 Classifier Platform only.

Below is a Scanning Mobility Particle Sizer™ Spectrometer
(SMPS™) data file of outdoor air illustrating Diffusion Loss
Correction. Diffusion losses are highly dependent on sample flow
rate and particle size. This data was taken using a very low flow
rate, so it is close to a “worst case scenario.”
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Aerosol Instrument Manager Data file of Outdoor Air Aerosol Instrument Manager Data file of Outdoor Air
without Diffusion Loss Correction with Diffusion Loss Correction

When Should | Use Diffusion Loss
Correction?

Ultrafine Particles

It is especially important to use Diffusion Loss Correction when
sizing aerosols smaller than 100 nm, since in this size regime
diffusion becomes increasingly significant. The correction is
negligible for aerosols larger than 100 nm.

Low Flow Rates

Sampling at low flow rates will also aggravate diffusion losses.

It is recommended to toggle the Diffusion Loss Correction and
observe the magnitude of the correction whenever viewing data.

Free Upgrade

TSI is offering Diffusion Loss Correction as a free upgrade to the
Aerosol Instrument Manager® software. To receive your upgrade
please contact TSI at particle@tsi.com with the instrument model
numbers and serial numbers of your component SMPS™ system.

Note: Diffusion Loss Correction is not currently available for the
Model 3034 Single-Box Scanning Mobility Particle Sizer™
Spectrometer.
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APPENDIX H

Scanning Mobility Particle
Sizer™ (SMPS™)
Spectrometer Nanoparticle
Aggregate Mobility
Analysis Software Module

Introduction

Urban ultrafine atmospheric aerosol and particle emissions from
combustion sources such as diesel engines are typically low fractal
dimension aggregates (D, < 2) composed of spherical primary
particles with diameter 5-50 nm. The nanoparticle aggregates are
also present in several nanomaterial production processes such as
manufacturing carbon black, titania and fumed silica. TSI
Scanning Mobility Particle Sizer™ (SMPS™) spectrometer is
commonly used to measure size distributions for these applications
and more. The SMPS™ spectrometer uses electrical mobility to
measure the particle size. This technique utilizes a bipolar charger
to impart a known charge distribution on the aerosol sample. The
particles are then classified according to their ability to traverse an
electric field. The most common method of interpreting electrical
mobility analysis to obtain size (in the SMPS™ spectrometer, as well
as other commercially available electrical mobility analyzers), is
based on a spherical particle model, including an expression for the
drag coefficient over a wide range of Knudsen numbers (Kn) and the
bipolar charging efficiency of spherical particles. While this method
is appropriate for sizing spherical particles, it leads to errors in the
mobility size data interpretation for aggregates, and subsequent
calculations of surface area and volume (and hence mass)
distributions.

A new method for analyzing mobility of nanoparticle aggregates for
a limiting case of idealized aggregates (D, < 2) has been developed
(Lall and Friedlander, 2006 a) and has been recently incorporated
in the Aerosol Instrument Manager® Software (version 8.0) for TSI
Model 3936 series SMPS™ spectrometer. This method yields a more
accurate estimate of the number, surface area and volume
distributions of nanoparticle aggregates. The mobility of aggregates
measured by an SMPS™ spectrometer is processed by a two module
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approach: one module for the drag on the aggregates and the other
Jor aggregate charging efficiency. This method requires the user to
input the average primary particle size of the aggregate. The
average primary particle size can be measured by electron
microscopy or, if available, taken from published literature. The TSI
Model 3089 Nanometer Aerosol Sampler in combination with the
electrostatic classifier and Differential Mobility Analyzer (DMA) can
be conveniently used to collect charged particles on a microscope
grid for electron microscopy. Some literature resources for
information on nanoparticle aggregate characteristics are papers by
Barone et al. (2006), Xiong and Friedlander (2001), and Park et al.
(2004 a, b).

This application note discusses the theory of idealized aggregates,
basic assumptions and implementation in the new updated Aerosol
Instrument Manager® software module. We also discuss user
operation of the software module and an example of analyzed data.

Note: The software module may be used for post-processing of
collected SMPS™ data, including data previously collected by
older versions of Aerosol Instrument Manager® software.

Theory

H-2

Assumptions — Limiting Case of Idealized
Aggregates

The nanoparticle aggregate mobility analysis software module
analyzes the SMPS™ data for aggregate number, surface area and
volume (mass) distributions based on certain assumptions. The
basic assumptions used in the calculations are as follows:

1. Aggregates are composed of primary particles all of which have
the same (known) diameter.

2. The primary particles that compose the aggregates are much
smaller than the mean free path of the surrounding gas
(Kn>> 1).

3. The total surface area of an aggregate can be obtained by
summing over all primary particles in the aggregate. This is the
maximum surface area which neglects the reduction due to
necks between the primary particles.

4. Aggregates are “transparent”, that is, (nearly) all surfaces are
directly exposed to collisions with molecules of a surrounding
gas. This is an acceptable approximation for aggregates with
fractal dimensions less than about two.

5. Two singly charged particles, an aggregate and a sphere, trace
the same path in the classifier if their migration velocities are
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equal: Both are said to have the same mobility diameter. The
Brownian diffusive spread is neglected.

6. Only ultrafine aerosol particles enter the mobility analyzer.
Larger particles are removed by a device (e.g., an impactor)
upstream of the SMPS™ spectrometer.

Calculations

The nanoparticle aggregate mobility analysis method is organized
into a two-module approach (as shown in Figure 1) for calculating
aggregate number, surface area and volume distributions from
DMA mobility data.

Mobility data
Module 1: Module 2:
Aggregate drag, relate Charging efficiency for
‘ N, and a with d,, given N, and a

a: Primary
particle radius

Scanning Mobility Particle Sizer (SMPS) Spectrometer
Nanoparticle Aggregate Mobility Analysis Software Module H-3



Module 1: Aggregate Drag

H-4

Consider an aggregate composed of N, particles of radius a and a
spherical particle of diameter d,, both with unit charge. If the two

have same migration velocity, then by equating the drag forces,
we get

d, _c*NpaZ
c(d,) 3z

(1)

Where, C is the slip correction, c* is the dimensionless drag force
and A is the mean free path of the gas. The value of c*is 6.62 (Chan
and Dahneke, 1981) for aggregates oriented parallel to the direction
of motion relative to gas and 9.17 (Dahneke, 1982) for aggregates
oriented perpendicular to the direction of motion. The method holds
well for N, > 10. For aggregates with D,< 2, using equation 1, the
number of primary particles in an aggregate with primary particle
size in the free molecular regime can be related to the diameter of a
sphere even in the transition regime (Kn ~ 1).
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Module 2: Charging Efficiency

The charging efficiency is the fraction of the particles of a given size
that have a certain number of charges at equilibrium. The fraction
of spheres and aggregates that assume unit charge after bipolar
charging in general differ. Expressions for calculating the charge
distributions are needed for both. The bipolar charging efficiency of
spheres used in the Aerosol Instrument Manager® software is given
by the Fuchs charge distribution. The charging efficiency of
aggregates, 7, (Wen et al., 1984) is given as:

(0, ~noJe

2
D kT @

e
Moy =7 €XP| =
Y (kT )
Where,

N, is the number of elementary charges

Np is the median charge number

e is the electronic charge

ke is the Boltzmann’s constant

T is the absolute temperature

D, is the charging equivalent diameter (N, > 10)
2aN

D, =— 3)
* " In2N,)

The median charge number is given by the following equation:

—  DgkT (N.Z
Np = —In| ——
2e N Z

(4)
Where,

N % is the ion concentration ratio

z % is the ion mobility ratio, For air, this ratio is usually taken

tobe 1.4/1.6

From equations 1 to 4, the charge distribution for aggregates can
be determined as a function of the mobility diameter.
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Number, Surface, and Volume Distribution of
Aggregates

Only a fraction of the charged particles pass through the DMA. The
true number of spheres or aggregates is obtained by correcting for
their charging efficiencies. For a given number of spheres or
aggregates that are detected at the exit from the DMA per unit
volume, the true number concentrations of aggregates and spheres
will differ because of different charging efficiencies. The algorithm
used to calculate the number distribution of aggregates (n,,) from
DMA mobility data is identical to the one used for spheres except
aggregate charge distribution described in equation 2 is used
instead of Fuchs charge distribution. Wang and Flagan (1990)
describes in detail the data inversion algorithm used in the Aerosol
Instrument Manager® software to derive number based size
distributions.

The surface area distribution (A,,) with respect to the mobility
diameter can be obtained from number distribution for aggregates
from the expression:

Aagg (dm):nagg (dm)Np(dm)‘]'ﬂ-a2 (5)

Similarly, the volume distribution [Vag g) with respect to the mobility
diameter can be obtained from the expression:

Vagg (d) =Ny (A )N, (d) (472° 13) ©)

The theory of idealized aggregates has been experimentally verified
by Lall et al. (2006 b).

Software Operation

H-6

The nanoparticle aggregate mobility analysis module is a part of the
Aerosol Instrument Manager” software for Model 3936 series
SMPS™ spectrometer. The user may select the nanoparticle
aggregate mobility analysis by checking the appropriate box in the
physical parameters tab of the software. The physical parameters
tab is located in the “Properties” section under both the File and
Run menus. This may be done either before or after data collection.
To revert back to spherical analysis method, the user needs to
uncheck the box. This type of user interface facilitates comparison
of both types of data—data obtained with spherical model as well as
the data analyzed by nanoparticle aggregate model.

Once the check box is checked, the user needs to input primary
particle diameter (in units of nanometers) of the aggregate; the
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default value is set to 10 nm. The user may also select the
aggregate orientation (parallel or random with respect to the electric
field). By default the software is set for parallel orientation. All
electrically conducting aggregates tend to align parallel to the
electric field due to the interaction of the induced dipole with the
field (Stober, Boose, & Prodi, 1974). Diesel exhaust, ambient
particles as well as most other ultrafine particles are conductive,
and thus have parallel orientation.

The nanoparticle aggregate mobility analysis software module may
be used for post-processing of previously collected SMPS™ data,
including data previously collected by older versions of Aerosol
Instrument Manager® software. It simply provides an alternative
processing of the same primary data.
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Figure H-2
Physical Properties Tab of the Aerosol Instrument Manager® Software Showing the
Nanoparticle Aggregate Mobility Analysis Module User Interface.

Note: Nanoparticle aggregate mobility analysis software module
was designed and validated for use with the Model 3080
Classifier Platform only.
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Example

Figures H-3a-c depict the comparison of number, surface area and
volume based mobility diameter distributions, respectively, of diesel
exhaust aggregates. The DMA calibration based on spherical
particles is compared with the nanoparticle aggregate model based
analysis using Aerosol Instrument Manager® software. This example
shows that the spherical model underestimates the surface area
and greatly over estimates the volume (hence, mass) concentrations
of diesel nanoparticle chain aggregates. The total number
concentration based on aggregate model was found to be in good
agreement with that measured directly by a CPC (Lall et al.,

2006 c).
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Figure H-3

Aggregate distribution functions based on standard calibration for spheres (Red)
compared with the distributions based on the idealized aggregate theory (Green).
Primary particle diameter = 17 nm, aggregate orientation: parallel to the electric
field. (a) Number Distributions, (b) Surface area distributions and (c) Volume
distributions. Courtesy: Lall et al., 2006 c.

Aerosol Instrument Manager® Software for SMPS™ Spectrometer



Summary and Conclusions

A new method for nanoparticle aggregate mobility analysis for a
limiting case of idealized aggregates (D,< 2) has been developed.
This method provides a more accurate estimate of number, surface
area and volume (hence, mass) distributions of nanoparticle
aggregates. The nanoparticle aggregate mobility analysis method
has been recently incorporated in the Aerosol Instrument Manager”
Software for TSI Model 3936 series SMPS™ spectrometer. The
software module may be used for post-processing of collected
SMPS™ data, including data previously collected by older versions
of Aerosol Instrument Manager® software. Existing SMPS™
customers may upgrade their Aerosol Instrument Manager”
software with the new nanoparticle aggregate mobility analysis
module for a nominal fee.

Note: The nanoparticle aggregate mobility analysis software module
is compatible with all (new and old) TSI model 3936 series
component SMPS™ systems, however, cannot be used with TSI
Model 3034 single box SMPS™ systems.
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APPENDIX |
Communication with

the Electrostatic
Classifier Model 3080

The Aerosol Instrument Manager® software is capable of
communicating with the TSI Model 3080 Electrostatic Classifier. If
you wish to use this communication, connect the computer to the
classifier with a serial cable or USB-to-serial cable.

If the Model 3080 classifier has been selected and auto-connect is
selected, the software will attempt to connect to the classifier when
you open a new document and when you open the properties
dialog.

If the connection attempt fails, you will be prompted to select a
COM port to use for this connection. If you cancel out of the dialog
without selecting a port you can continue using the Aerosol
Instrument Manager® software without connecting the software to
the classifier. You can also connect to or disconnect from the
classifier from the Run menu.

When the properties dialog is opened, if the software has succeeded
in connecting to the classifier, it reads the sheath temperature and
absolute pressure from the instrument and uses those values to
calculate gas viscosity and mean free path, which are used in other
calculations. If not connected, the software will use the reference
gas values from the properties dialog instead. The software does not
read the flow rates from the classifier when the properties dialog is
opened, so it does not use the values from the instrument to set the
values in the dialog.

When you close the properties dialog the software uses the values
from the dialog to set the sheath flow rate and bypass flow rate in
the classifier. It will set the sheath flow mode to the appropriate
value (dual or single blower) based on the selected flow rates and
will set the voltage mode to analog.



At the start of data collection for each sample, if connected to the
classifier, the software again reads the temperature and pressure
from the classifier to use in calculations and displays the
temperature and pressure at the bottom of the graph and tables. If
the values have not been read, the temperature and pressure will
appear as dashed lines instead. The software then waits, if
necessary, for the status flags in the classifier to signal OK before
starting data collection.

The following equations are used to calculate mean free path and
gas viscosity:

T, s s
T=-2 N=14— D=1+ —

p=-2
'PS TR TR TS

As =g »P+T = (N/p)

R )
As = Actual gas mean free path in meters
A, = Reference gas mean free path in meters (from Properties
dialog)
TS = Sample flow temperature in K (from Classifier)
T, = Reference temperature in K (from Properties dialog)
P, = Sample flow pressure in kPa (from Classifier)
P, = Reference pressure in kPa (from Properties dialog)
S = Sutherland Constant (from Properties dialog)
V. = Reference gas viscosity in Pa*s (from Properties dialog)
V. = Actual gas viscosity in Pa*s
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